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Coding

Linux Coding Tricks & Tips is the perfect

digital publication for the user that wants to take their skill
set to the next level. Do you want to enhance your user
experience? Or wish to gain insider knowledge? Do you
want to learn directly from experts in their field? Learn the
numerous short cuts that the professionals use? Over the
pages of the new advanced user guide you will learn
everything you will need to know to
become a more confident, better

skilled and experienced owner. L _0"9” Lhe pPage

A user that will make the W Journey Conlinyeg
absolute most of their coding and we w;ff be witl, a}
use and ultimately Linux itself. “? cvery clage to d“/y.
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exclusively help and teach you
the abilities we have gained over
our decades of experience.
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“There’s more to Linux than simply being a free to use operating system. Its
unique configuration allows the user to customise and personalise the OS
into any form they wish. A Linux user can change their OS look and feel from
one day to the next, install thousands of freely available apps and programs
and take back control of their computer.”
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Python
ON LINUX

Python is a fantastic programming language,
combining ease of use with a generous helping of
power to allow the user to create both minor utilities
or performance-heavy computational tasks.

However, there's more to Python than simply being
another programming language. It has a vibrant and
lively community behind it that shares knowledge,
code and project ideas, as well as bug Fixes for

future releases.

We've used a Raspberry Pi for this section of the
book, as it's Linux based and one of the best coding
platforms available. The Pi’s features and functions
make it the perfect Python programming partner, so
let’s get started.
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Python on Linux)
Why Python?

There are many different programming languages available for the modern computer,
and some still available For older 8 and 16-bit computers too. Some of these languages

are designed for scientific work, others for mobile platforms and such. So why choose
Python out of all the rest?

PYTHON POWER

Ever since the earliest home computers were available, enthusiasts, users and professionals have toiled away until the wee
hours, slaving over an overheating heap of circuitry to create something akin to magic.

These pioneers of programming carved their way into a new
frontier, forging small routines that enabled the letter ‘A’ to scroll
across the screen. It may not sound terribly exciting to a generation
‘hat’s used to ultra high-definition graphics and open world, multi-
dlayer online gaming. However, forty-something years ago it was
vlindingly brilliant.

Naturally these bedroom coders helped form the foundations for
every piece of digital technology we use today. Some went on to
become chief developers for top software companies, whereas
others pushed the available hardware to its limits and founded the
billion pound gaming empire that continually amazes us.

Regardless of whether you use an Android device, iOS device, PC,
Mac, Linux, Smart TV, games console, MP3 player, GPS device built-in
to a car, set-top box or a thousand other connected and ‘smart’
appliances, behind them all is programming.

All those aforementioned digital devices need instructions to tell
them what to do, and allow them to be interacted with. These
instructions form the programming core of the device and that core
can be built using a variety of programming languages.

The languages in use today differ depending on the situation, the
platform, the device’'s use and how the device will interact with its

:i* Bombs - GUI - ThelDE - [d:\uppsrc\CtriLib\ArrayCtrl.cpp windows-1252] { examples } [-_HE”EI
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environment or users. Operating systems, such as Windows, macOS
and such are usually a combination of C++, C#, assembly and some
Form of visual-based language. Games generally use C++ whilst web
pages can use a plethora of available languages such as HTML, Java,
Python and so on.

More general-purpose programming is used to create programs,
apps, software or whatever else you want to call them. They're
widely used across all hardware platforms and suit virtually every
conceivable application. Some operate faster than others and some
are easier to learn and use than others. Python is one such general-
purpose language.

Python is what's known as a High-Level Language, in that it ‘talks’
to the hardware and operating system using a variety of arrays,
variables, objects, arithmetic, subroutines, loops and countless
more interactions. Whilst it's not as streamlined as a Low-Level
Language, which can deal directly with memory addresses, call
stacks and registers, its benefit is thatit's universally accessible
and easy to learn.

//T1le: Invoke.java
import java.lang.reflect.*;

class Invoke { _ _ _
public static void main( string [] args ) {

try 1
Class ¢ = Class.forName( args[0] );

1
2
3
4
5
6
8

??t?o? ? = c.getMethod( args[1], new Class
Object ret = m.invoke( null, null );
System.out.printin(

"Invoked static method: " + args[1]

+ " of class: " + args[0]

+ " with no args\nResults: " + ret );

} catch ( ClassNotFoundException e )
// Class.forName/( can't find the class
} catch ( NoSuchMethodException e2 ) {
// that method doesn t exist
} catch ( I11eﬁa1Acce55EXCEption e3 ) 1
// we don't have permission to invoke that
method
} catch ( InvocationTargetException e4 ) {
// an exception ocurred while 1nvoking that
method
System.out.printin(
"Method threw an: " + e4.
getTargetException( ) );

ﬁ Javais a powerful

é language that’s used in
web pages, set-top boxes
TVs and even cars.

<Why Python?

Python was created over twenty six years ago and has evolved to
become an ideal beginner’s language for learning how to program a
computer. It's perfect for the hobbyist, enthusiast, student, teacher
and those who simply need to create their own unique interaction
between either themselves or a piece of external hardware and the
computer itself.

Python is free to download, install and use and is available for Linux,
Windows, macOS, MS-DOS, 0S/2, BeOS, IBM i-series machines, and
even RISC OS. It has been voted one of the top five programming
languages in the world and is continually evolving ahead of the
hardware and Internet development curve.

So to answer the question: why python? Simply put, it's free, easy to
learn, exceptionally powerful, universally accepted, effective and a
superb learning and educational tool.

A

Sl
m I

BASIC was once the starter language that early
8-bit home computer users learned.

print (HANGMAN[@])
attempts = len(HANGMAN) - 1

while (attempts != @ and "-" in word_guessed):
print( (" \nYou have {; attempts remaining”).format(attempts))
joined word = "".join(word guessed)
print(joined word)

try:
player_guess = str(input(”\nPlease select a letter between A-Z" + "\n> ")).
except: # check valid input
print("That is not valid input. Please try again.")
continue
el
if not player puess.isalpha(): # check the input is a letter. Also checks a
print(“"That is not a letter. Please try again.™)
continue
elif len(player puess) > 1: # check the input is only one letter
print(“That is more than one letter. Please try again.")
continue
elif player puess in guessed letters: # check 1t letter hasn't been guessed
print(“You have already guessed that letter. Please try again.”)
continue
else:
pass

guessed letters.append(player guess)
for letter in range(len(chosen word)):
if player guess == chosen_word[letter]:

word guessed[letter] = player guess # replace all letters in the chosen

if player_guess not in chosen_word:

P Python is a more modern take on BASIC, it's easy to learn
é and makes for an ideal beginner’s programming language.

www.pclpublications.com




j. Python on Linux>

How to Set Up
Python in Linux

While the Raspberry Pi's operating system contains the latest, stable version of Python,
other Linux distros don’t come with Python 3 preinstalled. If you're not going down the
Pi route, then here’s how to check and install Python for Linux.

PYTHON PENGUIN

Linux is such a versatile operating system that it's often difficult to nail down just one way of doing something. Different
distributions go about installing software in different ways, so we're sticking with Linux Mint for this particular tutorial.

STEP 1 First you need to ascertain which version of Python STEP 3 In our case we have both Python 2 and 3 installed;
is currently installed in your Linux system. To begin as long as Python 3.x.x is installed, then the code in
with, drop into a Terminal session from your distro’'s menu or hitthe  our tutorials will work. It's always worth checking to see if the distro

Ctrl+Alt+T keys. has been updated with the latest versions, so enter: sudo apt-get
update && sudo apt-get upgrade to update the system.

david@david-Mint: ~

File Edit View Search Terminal Help david@david-Mint: ~

david@david-Mint: Sl File Edit View Search Terminal Help

p david@david-Mint:~$ python --version

Python 2.7.15rcl

david@david-Mint:~$ python3 --version

Python 3.6.7

david@david-Mint:~$ sudo apt-get update && sudo apt-get upgrade
[sudo] password for david: |}

STEP 2 Next enter python --versioninto the Terminal STEP 4 Once the update and upgrade completes, enter:
screen. You should have the output relating to python3 --version again to see if Python 3.x

version 2.x of Python in the display. By default, most Linux distros is updated or even installed:; as long as you have Python 3.x, you're
come with both Python 2 and 3, as there’s plenty of code out there running the most recent major version. The numbers after the 3.
still available for Python 2. Now enter: python3 --version. indicate patches and further updates. Often they're unnecessary

but can contain vital new elements.

david@david-Mint: ~ T 1.1.3-50buntuo.

Get:2 http://archive.ubuntu.com/ubuntu bionic-updates/main amd64 libasound2-data
File Edit View Search Terminal Help all 1.1.3-5ubuntu®.2 [36.5 kB]
1 Get:3 http://archive.ubuntu.com/ubuntu bionic-updates/main amd64 linux-libc-dev
david@david-Mint:~$ python --version amd64 4.15.0-44.47 [1,013 kB]
Python 2.7.15rcl Fetched 1,409 kB in 0s (3,023 kB/s)
david@david-Mint:~$ python3 --version (Reading database ... 290768 files and dllectﬂrleﬁ_ curlepﬂy installed.)
Preparing to unpack .../libasound2 1.1.3-5ubuntu@.2 amd64.deb ...
Python 3.6.7 Unpacking libasound2:amd64 (1.1.3-5ubuntu®.2) over (1.1.3-5ubuntu@.l) ...
david@david-Mint:~$ |} Preparing to unpack .../libasound2-data 1.1.3-5ubuntu@.2 all.deb ...
Unpacking libasound2-data (1.1.3-5ubuntu®.2) over (1.1.3-5ubuntu@.l) ...
Preparing to unpack .../linux-libc-dev 4.15.0-44.47 amd64.deb ...
Unpacking linux-libc-dev:amd64 (4.15.0-44.47) over (4.15.0-43.46) ...
Setting up libasound2-data (1.1.3-5ubuntu®.2) ...
Setting up linux-libc-dev:amd64 (4.15.0-44.47) ...
Setting up libasound2:amd64 (1.1.3-5ubuntu@.2) ...
Processing triggers for libc-bin (2.27-3ubuntul) ...
david@david-Mint:~$ python3 --version
Python 3.6.7
david@david-Mint:~$ |

10 www.pclpublications.com



STEP 5 However, if you want the latest, cutting edge
version, you need to build Python from source. Start

by entering these commands into the Terminal:

sudo apt-get 1install build-essential checkinstall
sudo apt-get install libreadline-gplvZ-dev

LibncurseswS-dev libssl-dev libsglite3-dev tk-dev
Libgdbm-dev libcb-dev libbzZ2-dev

david@david-Mint: ~ .

Fle Edit View Search Terminal Help

david@david-Mint:~$ sudo apt-get install build-essential checkinstall
Reading package lists... Done
Building dependency tree
Reading state information... Done
build-essential is already the newest version (12.4ubuntul).
The following NEW packages will be installed
checkinstall
© to upgrade, 1 to newly install, @ to remove and 3 not to upgrade.
Need to get 97.1 kB of archives.
After this operation, 438 kB of additional disk space will be used.
Do you want to continue? [Y/n] y

STEP 6 Open up your Linux web browser and go to
the Python download page: www.python.org/
downloads. Click on Downloads followed by the button under
the Python Source window. This opens a download dialogue box;
choose a location and start the download process.

& python’

About

Opening Python-3.7.2.tar.xz

You have chosen to open:

Download Python-3.7.2.tarxz

which is: XZ archive (16.3 MB)
from: https://www.python.org

What should Firefox do with this file?

Hello, I'm Python! Openwith  Archive Manager (default)

Save File §

What is your name?
Python
H1i, Python.

Cancel

STEP 7 In the Terminal, go the Downloads folder by
entering cd Downloads/. Then unzip the contents
of the downloaded Python source code with: tar -xvf Python-

3.Y.Y.tar.xzreplacing the Y's with the version numbers

you've downloaded. Now enter the newly unzipped folder with cd
Python-3.Y.Y/.

nyaaﬁ— :

.2/0bjects/clinic/floatobject.c.h
.2/0bjects/clinic/funcobject.c.h
.2/0bjects/clinic/longobject.c.h
.2/0bjects/clinic/dictobject.c.h
.2/0bjects/clinic/structseq.c.h
.2/0bjects/clinic/tupleobject.c.h
.2/0bjects/clinic/moduleobject.c.h
.2/0bjects/clinic/odictobject.c.h
.2/0bjects/bytearrayobject.c
.2/0bjects/typeobject.c
.2/0bjects/1lnotab notes.txt
.2/0bjects/methodobject.c
.2/0bjects/tupleobject.c
.2/0bjects/obmalloc.c
.2/0bjects/object.c
.2/0bjects/abstract.c
.2/0bjects/listobject.c

Python- .2/0bjects/bytes methods.c

Python- .2/0bjects/dictnotes. txt
Python-3.7.2/0bjects/typeslots. inc
david@david-Mint; $ cd Python-3.7.2/
david@david-Mint: S

Python-3.
Python-3.
Python-3.
Python-3.
Python-
Python-
Python-
Python-
Python-
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-3.
Python-

ld Ll W Wl W W W W W W W w

B B B N e O L R N [ B N

W W W W www

How to Set Up Python in Linux

oy

STEP 8 Within the Python folder, enter:

./configure
sudo make altinstall

This could take a while depending on the speed of your computer.
Once finished, enter: python3.7 --version to checkthe
installed latest version. You now have Python 3.7 installed, alongside
older Python 3.x.x and Python 2.

checking whether compiling and linking against OpenSSL works... no
checking for --with-ssl-default-suites... python
configure: creating ./contig.status
config.status: creating Makefile.pre
config.status: creating Misc/python.pc
config.status: creating Misc/python-config.sh
config.status: creating Modules/ld so aix
config.status: creating pyconfig.h

creating Modules/Setup

creating Modules/Setup. local

creating Makefile

If you want a release build with all stable optimizations active (PGO, etc),
please run ./configure --enable-optimizations

david@david-Mint: $ sudo make altinstall

STEP S

sudo apt-get 1install 1dle3

For the GUI IDLE, you need to enter the following
command into the Terminal:

The IDLE can then be started with the command idle3. Note that
IDLE runs a different version from the one you installed from source.

david@david-Mint: ~/Downloads/Python-3.7.2 -

File Edit

david@david-Mint:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following additional packages will be installed:
blt idle idle-python3.6 python3-tk tk8.6-blt2.5
Suggested packages:
blt-demo tix python3-tk-dbg
The following NEW packages will be installed
blt idle idle-python3.6 idle3 python3-tk tk8.6-blt2.5

View Search Terminal Help

2$ sudo apt-get install idle3

@ to upgrade, 6 to newly install, © to remove and 3 not to upgrade.
Need to get 938 kB of archives.

After this operation, 4,221 kB of additional disk space will be used.
Do you want to continue? [Y/n] l

STEP 10 You also need PIP (Pip Installs Packages) which is a
tool to help you install more modules and extras.
Enter: sudo apt-get install python3-pip
When PIPis installed, check for the latest update with:
pip3 1nstall --upgrade pip

When complete, close the Terminal and Python 3.x will be available
via the Programming section in your distro’s menu.

david@david-Mint: ~/Downloads/Python-3.7.2 =

File Edit View Search Terminal Help

david@david-Mint: .
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following additional packages will be installed:

python-pip-whl python3-distutils python3-1ib2to3
Recommended packages:

python3-dev python3-setuptools python3-wheel
The following NEW packages will be installed

python-pip-whl python3-distutils python3-1ib2to3 python3-pip
@ to upgrade, 4 to newly install, @ to remove and 3 not to upgrade.
Need to get 1,984 kB of archives.
After this operation, 4,569 kB of additional disk space will be used.
Do you want to continue? [Y/n] J}

2$ sudo apt-get install python3-pip

www.pclpublications.com 11




Python on Linux)

Starting Python for
the First Time

If you're using the new Raspberry Pi together with its latest release of the Pi OS, then

you will need to manually install the Python IDLE. This is due to the Pi team removing
the core Python IDLE in Favour of their own coding text editor.

STARTING PYTHON

For those using the Pi4 and new Raspbian, drop into a Terminal and enter: sudo apt-get install idle3. Older versions of

Raspbian already have the official Python IDLE pre-installed.

STEP 1 With the Raspbian desktop loaded, click on the

Menu button followed by Programming > Python
3 (IDLE). This opens the Python 3 Shell. Windows and Mac users can
find the Python 3 IDLE Shell from within the Windows Start button
menu and via Finder.

-
L r:- ._F ]

LR
ﬂg-_mmmmmm

Pythen §.4.7 (defmily, Dct 18 JOO4, 18:81:11)

[GCC 4. %.0) en Limus

Typs “tapyright™, “cradite™ ar "lidendal)™ Fo " i i
e

STEP 2 The Shell is where you can enter code and see the
responses and output of code you've programmed
into Python. This is a kind of sandbox, where you're able to try out
some simple code and processes.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux

Type "copyright™, "credits™ or "license()" for more informatlion. M
>35>

*

| www.pclpublications.com

STEP 3 For example, in the Shell enter: 2+2
After pressing Enter, the next line displays the
answer: 4. Basically, Python has taken the ‘code’ and produced the
relevant output.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type "copyright”, "credits™ or "license()” for more information.
>>> 2+2

4
}}}l

A
n ‘|

The Python Shell acts very much like a calculator,
since code is basically a series of mathematical

STEP 4

interactions with the system. Integers, which are the infinite
sequence of whole numbers can easily be added, subtracted,
multiplied and so on.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux

Type "copyright”, "credits” or "license()" for more information. '
>2> 242
4 |
>>> 8+6 I

14

>>> 23453+64545522
64568975

>>> QB778642342-12343
98778629999

>>> 1287437%43534

S60472B2358
>>> |




<Starting Python for the First Time j‘

STEP 5 While that's very interesting, it's not particularly STEP 8 The Python IDLE is a configurable environment. If
exciting. Instead, try this: you don't like the way the colours are represented,
then you can always change them via Options > Configure IDLE and
clicking on the Highlighting tab. However, we don’t recommend

print(“Hello everyone!”)

Just enter it into the IDLE as you've done in the previous steps. that, as you won't be seeing the same as our screenshots.
'pytho: 3.4.2 (default. Oct 19 2014, 13:31:11) I o
P)fthﬂﬂ 3.4.2 Shell E "I['f:gg ..a.:gF.*FE'i;:t"anzredits“ or "license()" for more information. |
File Edit Shell Debug Options Windows Help :H i IDLE Preferences = x .‘|
Python 3.4.2 (default, Oct 19 2014, 13:31:11) Al TT = Fonts/Tabs | Highlighting | Keys | General |
[GCC 4.9.1] on lin >>> 23453+64545522 ) b o R
Type "copyright", Ifzr«a-r:i its" or "license()" for more information. gy LU R Dy ey :;?:Eltg?tmg Jome
>>> 2+2 98778629999 . s
4 >>> 1287437%43534 ‘+ a Built-in Theme
>>> 846 W - — " a Custom Theme
>>> 23453+64545522 | . __ | DLE Classk _ —~
64568975 ‘* Foreground  Background
>>> 98778642342-12343 #you can click here 21 =
9B778629999 #to choose 1tems
>»> 1287437*%43534 I---I!mfgrgiggfﬁ]:
S604728B2358 var0 = "string'
>33 nt("Hello ev al™) |
HE1lgr;:-\v.*uﬂ:t‘)lra::m*a-!'EI o :g:E 5 &
.u var3d = list(None)
|NEFFEORY cursor |
shell stdout stderr
ﬂ Save as New Custom Theme _
L E R E RN N R EEREERE RS REEREEDBRERERS AREENERERERNEEENBERNRNENESERERENRERSRNENENDNEDLERSH;. L BN N R N EENENERNESELEREERERNESENEBEBRERERENERERSENEAREERNRNS N ERENERNERERNSNREERERENNERNDNDS.ZS.)
STEP 6 This is a little more like it, since you've just produced STEP 9 Just like most programs available, regardless of the
your first bit of code. The Print command is fairly operating system, there are numerous shortcut
self-explanatory, it prints things. Python 3 requires the brackets as keys available. We don’t have room for them all here but within the
well as quote marks in order to output content to the screen, in this  Options > Configure IDLE and under the Keys tab, you can see a list
case the ‘Hello everyone!’ bit. of the current bindings.
- prlnt{"HEll‘D En\_lgr*}fgnpf "} IDLE Preferences =
HE l lu eyve r}rﬂ e I Fonts/Tabs | Highlighting | Keys | General |
" - Key Set
- I * Use a Built-in Key Set IDLE Classic Windows —
Delet m Ke Save as New Custom Key Set \
~ Custom Key Bindings -
Action - Key(s)
beginning-of-ine - <Key-Home= b
centerdnsert - <Control-Key-I> <Control-Key-L> i
change-indentwidth - <Alt-Key-u> <Meta-Key-u> <Alt-Key-U> =
check-module - <Alt-Key-x=>
close-all-windows - =Control-Key-q> <Control-Key-Q=>
close-window - <Alt-Key-Fd> =Meta-Key-Fi>
comment-region - <Alt-Key-3> <Meta-Key-3>
copy - =Control-Key-c> <=Control-Key-C>
cut - <Control-Key-x> <Control-Key-X>
dedent-region - <Control-Key-bracketleft> v
o |
Ok| Apoly| Cancel
L E N B E NN SR EENERERESN RS NEESENRERER SR ENERNERRENERESEREERERRESNREEENNERERSSERHNRHSEHSDNEHR,) L BB E R AN ERENEENERNESESNENEEERNERSEREEBEBNERERENERSRNNEERNERESNSRSENERENBERDRS SR NESNSEREHSNDSN.ZS.
i =2yA Youmay have noticed the colour coding within SR ThePythonIDLE is a power interface and one
the Python IDLE. The colours represent different that's actually been written in Python using one
elements of Python code. They are: of the available GUI toolkits. If you want to know the many ins and
. . outs of the Shell, we recommend you take a few moments to view
Black — Data and Variables Blue —User Functions : y . .
. www.docs.python.org/3/library/idle.html, which details many of
Green - Strings Dark Red — Comments ,
. . the IDLE's features.
Purple — Functions Light Red — Error Messages
Orange — Commands 25.5. IDLE
- IDLE i Python's integrated Desstlopmend and Loamimg Eranonmian
IDLE Colour Coding iy
= Coded i 100% puré Python, using the « kinves GUI 100/KE »

+ Python shall window [imaractive interpreter) with colonzing of code inpul, oulpul, and amor Messages

colou r Use for Examples & frlB-wandow lead eddon with mulliple undo, Python colorizng, sman indent, call bps, auto complebon, and olher featuses

= S@arch withim any WINodow replace withen aQitor windows, and seanch ||'IrE|Lb;|'I I'I'I'LH|I|:||EI' g, il;rmp}

= Jebugger with porsestant broakpomis, Sepping, and wewing of global and oCal namespaces

Black Data & variables 23.6 area T L S
25.5.1. Menus
Green Strlngs llHEllﬂ Wﬂrld” IDLE has two mam wandow types, 1he Shall window and the Edilor wadow It 5 possids & have mullipds edior wandows simultanaoersly. Oulpd windows, such &5 used for Edd / Find e Files, are a subtyps of edil wand;
T 1T currently have the same top manu &5 Edilor wandows. bul & difesent defaull e and contax] manu
P l.l I'p I E' Fun“:tlﬂ'n 5 1E n ( ) Pri n t ( } IDLE's menus dynamically change bated on which window is curmenlly selecied Each menu documanied balow indicales which window type il is essocabed wilh
o - 23.5.1.1. File menu (Shell and Editor)
Orange Commands if for else
J | 4l — Maw k0
» Craale a niw file adifing windiow
Blue User functions get area() o
Cipan an sishing fie with an Open dialog
Recenl Flas
Dark rEd CﬂmmEHlE #Reme:m'ber VAT :Tpen a st of recent fes. Chck one to opan i
- Dpan Module
Light red Error messages SyntaxError: Open an xsting modue (searches <ys patn

Clags Browser
Shine hincfnns clessss  and mathnels in fha rorren Fddnr file ina ree stne-hes In fhe shell e & rrwnril il el
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Python on Linux)

Your First Code

Essentially, you've already written your first piece of code with the ‘print(“Hello

everyone!”)’ function from the previous tutorial. However, let’s expand that and look at
entering your code and playing around with some other Python examples.

PLAYING WITH PYTHON

With most languages, computer or human, it’s all about remembering and applying the right words to the right situation.
You're not born knowing these words, so you need to learn them.

STEP 1

IF you've closed Python 3 IDLE, reopenitin
whichever operating system version you prefer. In
the Shell, enter the familiar Following:

print(“Hello”)

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type “copyright"”, “credits” or "license()" for more information.
>>> print(“"Hello")

Hello

>>»> | '

STEP 2

Just as predicted, the word Hello appears in the
Shell as blue text, indicating output from a string.
It's Fairly straightforward and doesn’t require too much explanation.
Now Cry:

print(“2+2”)

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux
Type “copyright”, “credits” or "license()" for more information. g
>>> print("Hello™)
Hello

>>»> print("2+2")
2+2

>>> |

14 www.pclpublications.com

You can see thatinstead of the number 4, the

STEP 3 , ,
output is the 2+2 you asked to be printed to the

screen. The quotation marks are defining what's being outputted
to the IDLE Shell; to print the total of 2+2 you need to remove
the quotes:

print(2+2)

=-.-ﬂ_..-.-

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11) |
[GCC 4.9.1] on linux

| Type “copyright”, “"credits" or "license()" for more information.
>>> print("Hello")

Hello

=>> print(“2+2%)

F o

>>> print(2+2)

4

>

>

S ==F: B You can continue as such, printing 2+2, 464+2343
and so on to the Shell. An easier way is to use a

variable, which is something we will cover in more depth later. For
now, enter:

a=2
b=2

-

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help
Python 3.4.2 (default, Oct 19 2014, 13:31:11) A

[GCC 4.9.1] on linux

Type “"copyright”, “credits"” or "license()" for more information.
>>> print(“"Hello")

Hello

>>> print("2+2")

2+2 I
>>> print(2+2)
4

>2>

>>> g=2

»>>> b=2

>>> |




What you have done here is assign the letters a
and b two values: 2 and 2. These are now variables,

STEP 5

which can be called upon by Python to output, add, subtract, divide
and so on for as long as their numbers stay the same. Try this:

print(a)
print(b)

Python 3.4.2 Shell
File Edit Shell Debug QOptions Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type “copyright”, “credits” or "license()" for more information.
>>> print("Hello™)

Hello

>>> print("“2+2")

2+2 |l

>>> print(2+2)

4
5>

>>> a=2

>>> b=2

>>> print(a)
2

>>> print(b)
2

>>> |

The output of the last step displays the current

values of both a and b individually, as you've asked
them to be printed separately. If you want to add them up, you can
use the following:

print(a+b)

This code simply takes the values of a and b, adds them together
and outputs the result.

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux
Type "copyright”, "credits™ or "license()" for more information.
>>> print(“Hello™)

Hello .
>>> print("2+2")
2+2

>>> print(2+2)
4

S5

>>> g=2

>>> b=2

>>> print(a)

2

>>> print(b)

2

| >>> print(a+b)
| 4

I
ﬁi_}}} |

STEP 7 You can play around with different kinds of variables
and the Print function. For example, you could

assign variables for someone’s name:

name="David”
print(name)

Python 3.4.2 Shell = Taf s
Eile Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux |
Type "copyright”, "credits™ or "license()” for more information.
>>> print(“Hello™)

Hello

>>> print(“2+2")

242

>>> print(2+2)

4

-

>>> g=2

»>>> pb=2

>>> print(a)

2

ﬁ >>> print(b)

gl 2

| >>> print(a+b)

4

>>> name="David"”

>>> print(name)

David

| >>>

Your First Code

STEP 8 Now let’s add a surname;

surname="Hayward”
print(surname)

You now have two variables containing a first name and a surname
and you can print them independently.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type "copyright”, "“credits"™ or “license()” for more information.
>>> name="David"

>>> print(name)

David

>>> surname="Hayward"

>>> print(surname)

Hayward
>>> |

[ PSS S ET A T e

I
STEP 9 IF we were to apply the same routine as before,
using the + symbol, the name wouldn’t appear

correctly in the outputin the Shell. Try it:

print(name+surname)

You need a space between the two, defining them as two separate
values and not something you mathematically play around with.

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help :
(Bt = & = Fldal o i Bk 0 Sndd  I5.my-44% .
Python 3.4.2 (default, Oct 19 2014, 13:31:11) |

[GCC 4.9.1] on linux

Type “copyright”, "“credits"” or "license()" for more information.
>>> name="David"”

>>> print(name) 1
David

>>> surname="Hayward"
>>> print(surname)
Hayward

>>»> print(name+surname)

DavidHayward
>>> |

STEP 10

print(name, surname)

In Python 3 you can separate the two variables
with a space using a comma:

Alternatively, you can add the space yourself;
print(name+” “+surname)

The use of the comma is much neater, as you can see.
Congratulations, you've just taken your first steps into the wide
world of Python.

— I ——— - == 1
Python 3.4.2 (default. Oct 19 2014. 13:31:11) =
[GCC 4.9.1] on linux ‘
Type "copyright”, "credits" or "license()" for more information.

>>> name="David" |

>>> print{name)
David

>>> surname="Hayward"

>>> print(surname)

Hayward

>>> print(name+surname)
DavidHayward

>>> print(name, surname)
David Hayward

>>> print(name+" "+surname)

David Hayward
il >>> |
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Saving and Executing

Your Code

While working in the IDLE Shell is perfectly fine for small code snippets, it's not

designed for entering longer program listings. In this section you're going to be
introduced to the IDLE Editor, where you will be working from now on.

EDITING CODE

You will eventually reach a point where you have to move on from inputting single lines of code into the Shell. Instead, the

IDLE Editor will allow you to save and execute your Python code.

First, open the Python IDLE Shell and when it's up,
click on File > New File. This will open a new window

STEP 1

with Untitled as its name. This is the Python IDLE Editor and within it
you can enter the code needed to create your future programs.

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help - tie B Famat Ran Cutions
Python 3.4.2 (default, Oct 19 2014, 13:31:11) A

[GCC 4.9.1] on linux
mﬂ |

Type "copyright”. "credits" or
»>> |
L E N BB BN RN EEBREEREDRNREREERERBRERENR SRR EEREERNE RN SR EREBESERNENRREREERBENRERENESNRSESENENSNRNLNDLNER!

"license()™ for more information.

The IDLE Editor s, for all intents and purposes, a
simple text editor with Python features, colour

STEP 2

coding and so on; much in the same vein as Sublime. You enter
code as you would within the Shell, so taking an example from the

previous tutorial, enter:

print(“Hello everyone!”)

*Urttheg®
i Bde Edt Fgrmat Bun Options Windows Help
|pr:|r~.r{ Hella eweryans! =)

Fi¢ Edk Shefl Debug Oplions Windows Help
Python 3,4.2 (defaalt, 0<t 19 2074, 13:31:11)

Al
[GCC 4.9.1) on linwx i
or "license()” for more information. -

Type “copyright”. “credira”
F 3

Y]
L 2Cok 0
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STEP 3 You can see that the same colour codingis in place
in the IDLE Editor as it is in the Shell, enabling you
to better understand what's going on with your code. However, to
execute the code you need to first save it. Press F5 and you get a
Save...Check box open.

Python 3.4 2 Shel ST it
Eile Edit Shell Debug Options Windows Help l Edo Edt Fgrmat Hunm Optons  Windows  Help
Python 3.4.2 (default, Oct 19 2014, 13:31:11) A Tt "Hell }
[GCC 4.9.1) on linux | | | Print( Hello everyonel™)
Type “copyright™, "credits" or "license()" for more informatien. -
e e S 3

- Source Must Be Saved

OK to Save?

oK Cancel !

STEP 4

Click on the OK button in the Save box and select a
destination where you'll save all your Python code.
The destination can be a dedicated folder called Python or you

can just dump it wherever you like. Remember to keep a tidy drive

though, to help you out in the future.

e e e R = Lt § Al et e b ot T 1

ET R e i d
|
|

print(“Hello everyone!™)

Save As el e

| Directory:  /home/pi/Documents

|
{

B3 _pycache__ | cake.py | loopl.py |
L) Blue) Projects || Circle.py | main.py |
5 Greenfoot Projects || graphics.py | namecount.py |
Python Code Hello, py | Square.py
Scratch Projects [ | img.py | test.py
| Addition.py | imgtest.py | wordgame.py
4 D

File name: |print hello Save |

Files of tvpe: Python files (*.pv.*.pvw) = | Cancel |




Enter a name for your code, ‘print hello’ for
example, and click on the Save button. Once the

STEP 5

Python code is saved it's executed and the output will be detailed in
the IDLE Shell. In this case, the words ‘Hello everyone!'.

pnnt hello.py - /home/pi/Documents/Python Code/p
File Cdit Format Run Options Windows [elp

print(“Helle everyone!®™)

Python 3.4.2 Shell i
Ele Eot Shell Debug Qptions Windows Help I

Python 3.4.2 (default, Oct 19 2014, 13:31:11) -
[GEC 4:9:1] on lanux

R i R EETHT uuuuuuuuuuuuuuuuuuuuuuuuuuuuuuu
;R
Hello everyone!

Type "copyright™, "credits” or "license()” for more infermation. I
e
»»> |

This is how the vast majority of your Python code
will be conducted. Enter it into the Editor, hit F5,

save the code and look at the output in the Shell. Sometimes things

will differ, depending on whether you've requested a separate
window, but essentially that's the process. It's the process we will
use throughout this book, unless otherwise stated.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1) on linux

Type "copyright”, "credits” or "license()" for more information.
>>>

Hello everyone!
>>> |

IFyou open the file location of the saved Python
code, you can see that it ends in a .py extension.

STEP 7

This is the default Python file name. Any code you create will be
whatever.py and any code downloaded from the many Internet
Python resource sites will be .py. Just ensure that the code is written
for Python 3.

Python Code
File Edit View Bookmarks Go Tools Help

| W v > |a] | /home/pi/Documents/Python Code &1
+ Directory Tree v 1
1= [ pi

i i pnnt

L =] Desktop hello.py

| £ [@ Documents
v [ BlueJ Projects
+ [ Greenfoot Projects
v [ __pycache__
<No subfolders>
+ [ Scratch Projects
+| [¥] Downloads
+| [&] Music
< [l Pictures

(Saving and Executing Your Code

STEP 8

a=~

=2

name="David”
surname="Hayward”

print(name, surname)
print (a+b)

Let’s extend the code and enter a few examples
from the previous tutorial:

IF you press F5 now you'll be asked to save the file, again, asit's been
modified from before.

Ele Edt she Debug Qptions Wndows Help

Python 3.4.2 (default, OCL 19 2004, 13:31:11)

[GCC 4.9.1] on linux

Type “copyright™. "credits” or “license({}" for mere informatien.
------------------------- uﬂm OO OO O O T O O

STEP 9 IF you click the OK button, the File will be

overwritten with the new code entries, and
executed, with the outputin the Shell. It's not a problem with just
cthese few lines but if you were to edit a larger file, overwriting can
become an issue. Instead, use File > Save As from within the Editor
L0 create a backup.

.

print hello.py - /home/pi/Documents/Python Code/print hellopy (342) - o x

File | Edit Format Run Options Windows Help |
-- i

New File Ctri+N

Qpen... Ctrl+0
Recent Files -
Open Module... Alt+M

Class Browser Alt+C

Path Browser

Save Ctrl+5

Save As... EtrI+Er.:§t+5
Save Copy As... Alt+Shift+S
Print Window  Ctrl+P

Close Alt+F4

Exit ctrl+Q

STEP 10 Now create a new file. Close the Editor, and open
a new instance (File > New File from the Shell).

Enter the following and save it as hello.py:

a="Python”
b=!!‘_i_ S!'!

c="cool
print(a, b, c)

'H‘

You will use this code in the next tutorial.

r
r hello.py - /nome/pi/Documents/Python Code/hello.py (3.4.2) = CIae%

File Edit Format Run QOptions Windows Help

%
a="Python —

D="15"
c="cool!"
print(a. b, ¢)
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Fxecuting Code
-rom the Terminal

Although we're working from the GUI IDLE throughout this book, it's worth taking

a look at Python's command line handling. We already know there’'s a command line
version of Python but it's also used to execute code.

COMMAND THE CODE

Using the code we created in the previous tutorial, the one we named hello.py, let's see how you can run code that was made

in the GUI at the command line level.

STEP 1 Python, in Linux, comes with two possible ways of
executing code via the command line. One of the
ways is with Python 2, whilst the other uses the Python 3 libraries
and so on. First though, drop into the command line or Terminal on
your operating system.

pi@raspberrypi: ~
File Edit Tabs Help

Just as before,

STEP2 Raatl
we're using a

Raspberry Pi: Windows users will
need to click the Start button and
search for CMD, then click the
Command Line returned search:
and macOS users can get access
to their command line by clicking
Go > Utilities > Terminal.

B B & Filter

Best match

Deskiop app
Search suggestions »

/D cmd - See web results

18 www.pclpublications.com

STEP 3 Now you're at the command line we can start
Python. For Python 3 you need to enter the
command python3 and press Enter. This will put you into the
command line version of the Shell, with the familiar three right-
Facing arrows as the cursor (>>>).

pi@raspberrypi: ~

File Edit Tabs Help

From here you're able to enter the code you've

STEP 4 ,
looked at previously, such as:

File Edit Tabs Help




STEP 5

Now enter: exit() to leave the command line Python
session and return you back to the command
prompt. Enter the folder where you saved the code from the
previous tutorial and list the available files within; hopefully you
should see the hello.py file.

pi@raspberypi: ~/Documents/Python Code
File Edit Tabs Help

STEP 6

From within the same folder as the code you're
going to run, enter the following into the

command line:

python3 hello.py

This will execute the code we created, which to remind you is:

a="Python”
b=”-i_S”
c="cool!”
print(a, b, c)

STEP 7 Naturally, since this is Python 3 code, using the
syntax and layout that's unique to Python 3, it only

works when you use the python3 command. If you like, try the same
with Python 2 by entering:

python hello.py

pi@raspberrypi: ~/Documents/Python Code
File Edit Tabs Help

Di1Eraspberrypl

<Executing Code from the Terminal

STEP 8 The result of running Python 3 code from the
Python 2 command line is quite obvious. Whilst it
doesn’t error out in any way, due to the differences between the
way Python 3 handles the Print command over Python 2, the result
isn’t as we expected. Using Sublime for the moment, open the
hello.py file.

B C\Users\david\Documents\Python\hello.py - Sublime Text (UNREGISTERED)

File Edit Selecion Find View Goto Tools Project Preferences Help

1 a="Python”

) p=Mic™
c="cool!”

4 print(a, b, c)

hello.py ¥

STEP 9 Since Sublime Text isn’t available for the Raspberry
Pi, you're going to temporarily leave the Pi for the

moment and use Sublime as an example that you don’t necessarily
need to use the Python IDLE. With the hello.py file open, alterit to
include the following:

name=1nput(“What 1s your name? )
print(“Hello,”, name)

=
File Edit

Selection Find View Goto lools

4 print(a, b, c)
5 name=input("What is your name? '
print=("Hell

‘‘‘‘‘‘

STEP 10

code with:

Save the hello.py file and drop back to the
command line. Now execute the newly saved

python3 hello.py

The result will be the original Python is cool! statement, together
with the added input command asking you for your name, and
displaying it in the command window.

pi@raspberrypi: ~/Documents/Python Code

cdit Tabs Help

- e

19
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Python on Linux)

Numbers and Expressions

We've seen some basic mathematical expressions with Python, simple addition and the

like. Let’'s expand on that now and see just how powerful Python is as a calculator. You
can work within the IDLE Shell or in the Editor, whichever you like.

IT'S ALL MATHS, MAN

You can get some really impressive results with the mathematical powers of Python; as with most, if not all, programming

languages, maths is the driving force behind the code.

STEP 1 Open up the GUI version of Python 3, as mentioned
you can use either the Shell or the Editor. For the
time being, you're going to use the Shell just to warm our maths

muscle, which we believe is a small gland located at the back of the
brain (or not).

Python 3.4.2 Shell
Eile Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11) | 4|
[GCC 4.9.1] on linux

Type "copyright”, "credits™ or "license()" for more information.
>

STEP 2 In the Shell enter the following:

T
543560+34553245
99867344*2 /7344484221

You can see that Python can handle some quite large numbers.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default. Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type “copyright™, "credits™ or "license()" for more information.
>2> 2+

4

>>> 54356+34553245

24607601

>>> 90B67344%2734448B4221

2730821012201179024
>
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STEP 3 You can use all the usual mathematical operations:
divide, multiply, brackets and so on. Practise with a
Few, for example:

172

/2

2E72%3
(1+2)+(3*4)

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux
Type "copyright”. "credits™ or "license()" for more information.
> J¥v)
4
>>> 54356+34553245
34607601
>>»> 99B67344%27344484221
2730821012201179024
>»> 1/2
|o.5
>
oy 6/2 -

>>> 2+2%3

8

»»> (1+2)+(3%4)
15

>>> |

STEP 4 You've no doubt noticed, division produces a
decimal number. In Python these are called floats,
or floating point arithmetic. However, if you need an integer as
opposed to a decimal answer, then you can use a double slash:

1/77
6//2

And so on.

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default. Oct 19 2014, 13:31:11) A
[GCC 4.9.1] on linux

Type “copyright". "credits"” or "license()" for more information.
>»> 2+2

4

»2> 54356+34553245
34607601

>>> 99BG67344%27344484221
2730821012201179024

>»>> 1/2

0.5

>>> 6/2 -
3.0 |
>>> 2+2%3

g

»>> (1+2)+(3*4)
15

»>> 1//2

0

»>>> 6//2

3

}}}l




STEP 5

You can also use an operation to see the remainder
left over from division. For example:

10/3

Will display 3.333333333, which is of course 3.3-recurring. If you
now enter:

10%3

This will display 1, which is the remainder left over from dividing 10
into 3.

- = et -FTT T — B L i i

2730821012201179024
»2> 1/2

0.5

>>> 6/2

3.0

3> 2+2%3

g

>>> (1+2)+(3*4)

15

>2>> 1//2

0

»>> 6//2

3

»>>> 10/3
3.33332333333333335
>>> 10%3

1

STEP 6

Next up we have the power operator, or
exponentiation if you want to be technical. To work
out the power of something you can use a double multiplication
symbol or double-star on the keyboard:

P
10**10

Essentially, it's 2x2x2 but we're sure you already know the basics
behind maths operators. This is how you would work it out in Python.

>>»>> 6/2

3.0

>33 2+2%3

g

>>> (1+2)+(3*%4)
15

>>> 1//2

0

>>> 8//2

3

>>> 10/3
3.3333333333333335
>>> 10%3

1

>>» 2%k3

8

>>> 10%¥*10
10000000000

> >

STEP 7

Numbers and expressions don’t stop there. Python
has numerous built-in functions to work out sets
of numbers, absolute values, complex numbers and a host of
mathematical expressions and Pythagorean tongue-twisters. For
example, to convert a number to binary, use:

bin(3)

»>> 1/2
0.5
| >>> 6/2
3.0
>>> 2+2%3
8
>>> (1+2)+(3%4)
15
>>> 1//2
0
>>> 6//2
3
»>> 10/3
3.3333333333333330
>>> 10%3
1
>>» 2%¥3
8
>>> 10%*10
10000000000
>>> bin(3)
"0b11°

>>> |

Numbers and Expressions

STEP 8 This will be displayed as ‘'0b11’, converting the
integer into binary and adding the prefix Ob to the

Front. IFf you want to remove the 0b prefix, then you can use:
format(3, ‘b’)

The Format command converts a value, the number 3, to a
formatted representation as controlled by the format specification,
the ‘b’ part.

2> 2+2%3

8

>>> (1+2)+(3%4)
15

>>> /72

0
>>»> G//2

3

>>> 10/3
3.3333333333333335
>>> 10%3

1

> k]

8

»>>> 10%*10
10000000000

>>> bin(3)

“0b11°

>>> format(3,'b")
l11ln

=

STEP 9 A Boolean Expression is a logical statement that will
either be true or false. We can use these to compare

data and test to see if it's equal to, less than or greater than. Try this
in a New File:

"-"'-' L
£l = 6 Booleantest py - /home/pi/Di
b 7 Eile Edit Format Run Options Window
i[a =6

print(l, a == 6) print(1. a == &

(] a
print(2, a — 7) ﬂEﬁﬂiE:%ﬁzz:zi
print(s, d — 6 and b — 7) Eﬁﬁ;giﬁiﬁffann
print(4, a == 7 and b == 7) i i g g oy g
print(5, not a == 7 and b == 7)
print(6, a — 7orb — 7)
print(7, a == 7 or b == 6)
print(8, not (a == 7 and b == 6))
print(9, not a == 7 and b == 6)

STEP 10 Execute the code from Step 9, and you can see a
series of True or False statements, depending on

the result of the two defining values: 6 and 7. It's an extension of
what you've looked at, and an important part of programming.

Python 3.4.2 Shell =y =] ‘

File Edit Shell Debug Options Windows Help é

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux

Type "copyright”, “"credits” or "license()" for more information. =4|
>>> ================================ RESTART ================================
>

1 True

2 False

3 True

4 False

2 True

6 True

7 False

8 True

9 False
}}}I
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Using Comments

When writing your code, the flow, what each variable does, how the overall program

will operate and so on is all inside your head. Another programmer could follow the
code line by line but over time, it can become difficult to read.

#COMMENTS!

Programmers use a method of keeping their code readable by commenting on certain sections. If a variable is used, the
programmer comments on what it's supposed to do, for example. It’s just good practise.

Start by creating a new instance of the IDLE Editor
(File > New File) and create a simple variable and

STEP 1

print command:

a=10
print(“The value of A 1s,”, a)

Save the file and execute the code.

I Comments.py - /home/pi/Documen../Python Code/Comments.py (3.42) - O X
File Edit Format Run Options Windows Help

a=10 Tﬂ

print("The value of A 1s,", a)

Running the code will return the line: The value of A
is, 10 into the IDLE Shell window, which is what we

STEP 2

expected. Now, add some of the types of comments you'd normally
see within code:

# Set the start value of A to 10
a=10

# Print the current value of A
print(“The value of A 1s,”, a)

*Comments.py - fhome/pi/Docume..Python Code/Comments.py (3.4.2)* - O X

File Edit Format Run Options Windows Help
# Set the start value of A to 10 =

a=10
# Print the current value of A
print(“The value of A is,”, a)
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Resave the code and execute it. You can see that the
output in the IDLE Shell is still the same as before,

STEP 3

despite the extra lines being added. Simply put, the hash symbol (#)
denotes a line of text the programmer can insert to inform them,
and others, of what's going on without the user being aware.

Python 3.4.2 Shell sl
File Edit Shell Debug Options Windows Help 1

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux

Type "copyright”, "credits™ or "license()” for more information.

>>> =s=sss=ssssssssssssssssss=ss====== RESTART ===s==ssss==ssssssss=ssssssss==== I‘
>

The value of A 1s, 10

IO SR RESTAR] messsssssssssssssssasmssSEEE S-S

>

The value of A 1is, 10
>3

STEP 4 Let's assume that the variable A that we've created
is the number of lives in a game. Every time the
player dies, the value is decreased by 1. The programmer could
insert a routine along the lines of:

a=a-1
print(“You’ve just lost a life!”)
print(“You now have”, a, “lives left!”)

N

*Comments.py - /home/pi/Docume..Python Code/Comments.py (3.42)* - O X
~ File Edit Format Run Options Windows Help

# Set the start value of A to 10 Al
a=10

'| # Print the current value of A

' print(“The value of A 1s5.", a)

a=a-1

print{“You've just lost a life!"™)
print(“You now have", a, "lives left!")




STEP 5

Whilst we know that the variable A is lives, and
that the player has just lost one, a casual viewer or
someone checking the code may not know. Imagine for a moment
that the code is twenty thousand lines long, instead of just our
seven. You can see how handy comments are.

Python 3.4.2 Shell
Eile Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux
Type "copyright”, "credits"™ or “"license()" for more infermation.

>

The value of A 1s. 10

23> wessssssssssssssssssessssssssssss RESTART =esssssssssssssssssssssssssssssss
B

The value of
e ==
>3

The value of A 1s, 10
You've just lost a life!

You now have 9 lives left!
>35>

Il
Il
Il
Il
Il
Il
Il
Il
Il
Il
Il
Il
Il
I
I
2
m
Ty ]
pull
2
|
I
I
I
|
I
I
|
I
I
I
I
I
I
|
I
I
|
I
I
I
I
|
I
I
I
I
I
I
I
I
I
|

STEP 6

Essentially, the new code together with comments
could look like:

# Set the start value of A to 10

a=10

# Print the current value of A

print(“The value of A 1s,”, a)

# Player lost a life!

a=a-1

# Inform player, and display current value of A
(lives)

print(“You’ve just lost a life!”)

print(“You now have”, a, “lives left!”)

File Edit Format Run Options Windows Help

# Set the start value of A to 10 | A
a=10
# Print the current value of A
‘i print(“The value of A 1s5,”, a)
# Player lost a life!
a=a-1
# Inform player, and display current value of A (lives)
print(“"You've just lost a life!™)
print("You now have"”, a, "lives left!"™)

i

STEP 7 You can use comments in different ways. For
example, Block Comments are a large section of
text that details what's going on in the code, such as telling the code
reader what variables you're planning on using:

# This 1s the best game ever, and has been
developed by a crack squad of Python experts

# who haven’t slept or washed in weeks. Despite
being very smelly, the code at least

# works really well.

File Edit Format Run Options Windows Help

# This 1s the best game ever, and has been developed by a crack squad of Python experts

# who haven't slept or washed in weeks. Despite being very smelly, the code at least
‘i # works really well, |

# Set the start value of A to 10
a=10

# Print the current value of A
print("The value of A 1s,™, a)
# Player lost a life!

a=a-1

# Inform player, and display current value of A (lives)
print(“You've just lost a life!"™)
print(“"You now have"”, a, "lives left!")

(Using Comments

STEP 8 Inline comments are comments that follow a section
of code. Take our examples from above, instead of

inserting the code on a separate line, we could use:

a=10 # Set the start value of A to 10

print(“The value of A 1s,”, a) # Print the current
value of A

a=a-1 # Player lost a life!

print(“You’ve just lost a life!”)

print(“You now have”, a, “lives left!”) # Inform
player, and display current value of A (lives)

T

I Comments.py - /nome/pi/Documents/Python Code/Comments.py (3.4.2) - 0O X
File Edit Format Run Options Windows Help
a=10 # Set the start value of A to 10 -

print{~"The value of A 1s5,”, a) # Print the current value of A
a=a-1 # Player lost a life!
print{“You've just lost a life!"™)

print("You now have", a, "lives left!") # Inform player, and display current value of A (lives

The comment, the hash symbol, can also be used to

comment out sections of code you don't want to be
executed in your program. For instance, if you wanted to remove
the first print statement, you would use:

# print(“The value of A 1s,”, a)

# Set the start value of A to 10

a=10
|# Print the current value of A
i # print("The value of A is.,", a)|
# Player lost a life!
a=a-1
# Inform player., and display current value of A (lives)
print("You've just lost a life!™)
print("You now have”, a, "lives left!"™)

STEP 10 You also use three single quotes to comment
out a Block Comment or multi-line section of
comments. Place them before and after the areas you want to
comment for them to work:

[

This 1s the best game ever, and has been developed
by a crack squad of Python experts who haven’t
slept or washed 1n weeks. Despite being very
smelly, the code at least works really well.

) 3

1% mar w ¥ b L ol u LWL w N R - —_— —

File Edit Format Run Options Windows Help

A

This 1s the best game ever, and has been developed by a crack squad of Python experts
who havenOt slept or washed in weeks. Despite being very smelly, the code at least
works really well]

# Set the start value of A to 10

a=10

# Print the current value of A

# print("The value of A 1s5.", a)

# Player lost a life!

a=a-1

# Inform player, and display current value of A (lives)
print(“"You've just lost a life!"™)

print{“You now have®”, a, "lives left!"™)
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Working with Variables

We've seen some examples of variables in our Python code already but it's always
worth going through the way they operate and how Python creates and assigns certain

values to a variable.

VARIOUS VARIABLES

You'll be working with the Python 3 IDLE Shell in this tutorial. If you haven’t already, open Python 3 or close down the previous

IDLE Shell to clear up any old code.

In some programming languages you're required

to use a dollar sign to denote a string, which is a
variable made up of multiple characters, such as a name of a person.
In Python this isn’'t necessary. For example, in the Shell enter:
name="David Hayward” (or use your own name, unless you're
also called David Hayward).

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help
[ Badibio: & & % Edcl-adld ek S5 Shed IB-oW=-8% TS
Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type “copyright™, “credits” or "license()" for more information.
>>> name="David Hayward"

>»>> print (name)

David Hayward

>3

=

STEP 2 You can check the type of variable in use by
issuing the type () command, placing the name of
the variable inside the brackets. In our example, this would be:
type (name).Add a new string variable: t1tle="Descended
from Vikings”.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11) -
[GCC 4.9.1] on linux

Type “copyright”, “"credits” or “"license()" for more information.
>>> name="David Hayward"

>>> print (name)

David Hayward

>>> type (name)

<class "str'»

> fit1E="DESEEndEd from Vikings™
>3
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=0l You've seen previously that variables can be
concatenated using the plus symbol between the
variable names. In our example we can use: print (name + “:
“ + title).The middle part between the quotations allows us to

add a colon and a space, as variables are connected without spaces,
so we need to add them manually.

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11) =ﬂ
[GCC 4.9.1] on linux

Type "copyright”, "credits™ or "license()"” for more information.

>>> name="David Hayward"

>>> print (name) H

David Hayward )
>>> type (name)

<class 'str'>

>>> title="Descended from Vikings"

>>> print (name + “: " + title)
Davif Hayward: Descended from Vikings
55>

STEP4 Beucia oo
combine variables

Eile Edit Shell Debug QOptions Windows Help
within another variable. For

Python 3.4.2 (default, Oct 19 2014, 13:31:f
example, to combine both name

[GCC 4.9.1] on linux

Type "copyright”, "credits” or "license()" '
and title variables into a new
variable we use:

11 11

character=name + *: +
title

Then output the content of the
new variable as:

print (character)

Numbers are stored as different
variables:

age=44
Type (age)

Which, as we know, are integers.

>>> name="David Hayward"

>>> print (name)

David Hayward

>>> type (name)

<class "str’'>

>>> title="Descended from Vikings"
>>> print (name + “: " + title)

David Hayward: Descended from Vikings
>>> character=name + ": " + title

»>>> print (character)

David Hayward: Descended from Vikings
>>> age=44

>>> type (age)

<class 'int'>

>




However, you can’t combine both strings and
integer type variables in the same command, as you

STEP 5

would a set of similar variables. You need to either turn one into the
other or vice versa. When you do try to combine both, you get an
error message;

print (name + age)

Pythun 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux
Type "copyright”, "credits" or "license()"
>>> name="David Hayward"
>>> print (name)
David Hayward
>>> type (name)
<class "Sir's
>>> title="Descended from Vikings"
>>> print (name + “: " + title)
David Hayward: Descended from Vikings
>>> character=name + “: " + title
>>> print (character)
David Hayward: Descended from Vikings
>>> age=44
>>> type (age)
<class "int'>
>>> print (name+age)
Traceback (most recent call last):
File "<pyshell#9>", line 1, 1n <module>
print (name+age)
TypeError: Can't convert 'int’
>>> |

for more information.

object to str implicitly

This is a process known as TypeCasting. The Python
code is:

print (character + “ 1is
old.”)

|1 S 14

+ str(age) + “ years

Or you can use:

€ 14

print (character, “is“, age, “years old.”)

Notice again that in the last example, you don’t need the spaces
between the words in quotes as the commas treat each argument
to print separately.

>>> print (name + age)
Traceback (most recent call last):
File "<pyshell#18>", line 1, 1n <module>

print (name + age)
TypeError: Can't convert 'int’ object to str implicitly
>>> print (character + " 1s " + str(age) + " years old.")
David Hayward: Descended from Vikings 1s 44 years old.
>>> print (character, "1s", age, "years o0ld.")

David Hayward: Descended Trom Vikings 1s 44 years old.
220

>>> |
L E N B BN N B R EEBEERENS SRR EESEERBEER BEEN EESE N BN R EERNERNE SRR EESNBENER NERE N NESNERE.,

Another example of TypeCasting is when you ask for
input from the user, such as a name. for example,

STEP 7

enter:

age= input (“How old are you? *)

All data stored from the Input command is stored as a string variable.

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014,
[GCC 4.9.1] on linux
Type “copyright”, "credits" or "license()" for more information.
>>> age= input ("How old are you? ™)

How old are you? 44

»>>> type(age)

<class 'str'>

»>> |

13:31:11)

<Working with Variables

STEP 8 This presents a bit of a problem when you want to
work with a number that's been inputted by the

user, as age + 10 won’t work due to being a string variable and an
integer. Instead, you need to enter:

1nt(age) + 10

This will TypeCast the age string into an integer that can be
worked with.

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux
Type “"copyright”, “credits" or "license()" for more information.
>>> age= 1nput ("How old are you? ™)
How old are you? 44
>>> type(age)
<class 'str'>
>>> age + 10
Traceback (most recent call last):
File "<pyshell#2>", line 1, in <module>
age + 10
TypeError: Can't convert "int' object to str implicitly
>>> 1nt(age) + 10
54
>>> |

STEP 9 The use of TypeCasting is also important when
dealing with floating point arithmetic; remember:

numbers that have a decimal point in them. For example, enter:

sh1irt=19.99

Now enter type(shirt) andyou'll see that Python has allocated
the number as a ‘float’, because the value contains a decimal point.

e

Python 3.4.2 Shell \

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default., Oct 19 2014, 13:31:11)
[GCC 4.9.1] on linux
Type "copyright”, "credits"” or "license()" for more information.
>>> shirt=19.99
>>>» type(shirt)
<class *float'>

>5> |

STEP 10 When combining integers and floats Python
usually converts the integer to a float, but should

the reverse ever be applied it's worth remembering that Python
doesn’t return the exact value. When converting a float to an
integer, Python will always round down to the nearest integer,
called truncating; in our case instead of 19.99 it becomes 19.

]
Python 3.4.2 Shell ‘

File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type "copyright™, "credits™ or "license()” for more information.
»>>> shirt=19.99

»>> type(shirt)

<class ‘float'>

>>> int(shirt)

19

»>>> |
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User Input

We've seen some basic user interaction with the code from a few of the examples

earlier, so now would be a good time to focus solely on how you would get information

from the user then store and present it.

USER FRIENDLY

The type of input you want from the user will depend greatly on the type of program you're coding. For example, a game may
ask for a character’s name, whereas a database can ask for personal details.

IFit's not already, open the Python 3 IDLE Shell,

STEP 1 e . , —
and start a New File in the Editor. Let’s begin with

something really simple, enter:

print(“Hello”)

firstname=1nput(“What 1s your first name? “)
print(“Thanks.”)

surname=input(“And what 1s your surname? )

File Edit Format Run Options Windows Help

print(“Hello")

firstname=input("What is your first name? ")
print(“Thanks."™)

surname=input("And what 1s your surname? ")

STEP 2

Save and execute the code, and as you already no
doubt suspected, in the IDLE Shell the program will
ask for your first name, storing it as the variable firstname, followed
by your surname; also stored in its own variable (surname).

Python 3.4.2 Shell
File Edit Shell Debug Options Windows Help
Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux
Type “copyright”, “credits” or “license()" for more information.

3% 1 T ' T P T 1T " E R R 3§ P F T ¢t T T P S A T P R Y T T P T 0 11 HESTART --------------------------------
-

Hello
What 1s your first name? David
Thanks.

And rhat 1S your surname? Hayward
>>>

28 www.pclpublications.com

Now that we have the user’'s name stored in a
couple of variables we can call them up whenever

STEP 3

we want:

14

print(“Welcome”, firstname, surname,
you’re well today.”)

. I hope

*userinput.py - /home/pi/Documents/Python Code/usennputpy (3.4.2)* - x
File Edit Format Run Options Windows Help

print({“Hello™)

firstname=1input({"What is your first name? ")

print(“Thanks.™)

surname=input(“And what is your surname? ")

‘ print{“wWelcome", firstname, surname,”. I hope you're well today.")

STEP 4 Run the code and you can see a slightissue, the
-ull stop after the surname follows a blank space.
To eliminate that we can add a plus sign instead of the comma in
the code:

1

print(“Welcome”, firstname, surname+
you’re well today.”)

. I hope

*userinput.py - /home/pi/Documents/Python Code/usennputpy (3.4.2)* - O X
File Edit Format Run Options Windows Help

print(“Hello"™)
firstname=input("what 1is your first name? ")

print(“Thanks.")

surname=input("And what is your surname? ")

print(“Welcome”, firstname, surname+". I hope you‘re well today.")




You don't always have to include quoted text within
the input command. For example, you can ask the

STEP 5

user their name, and have the input in the line below:

print(“Hello. What’s your name?”)
name=1nput()

T LTI
usennput.py - /home/pi/Documents/Python Code/us:

File Edit Format Run Options Windows Help

print(“Hello. What's your name?")
name=1nput()

|

The code from the previous step is often regarded
as being a little neater than having a lengthy

amount of text in the input command, butit’'s not a rule that's set in
stone, so do as you like in these situations. Expanding on the code,
try this:

print(“Halt! Who goes there?”)
name=1nput()

*userinput.py - /home/pi/Documents/Python Code/usernnputpy (3.4.2)* -
File Edit Format Run Options Windows Help

name=1input()

It's a good start to a text adventure game, perhaps?
Now you can expand on it and use the raw input

STEP 7

From the user to flesh out the game a little:

1f name=="David”:

print(“Welcome, good sir. You may pass.”)
else:

print(“I know you not. Prepare for battle!”)

T S T T T
userinput.py - /home/pi/Documents/Python Code/userinputpy (342) - 0 x

File Edt Format Run Options Windows Help

?
print(“Halt! wWho goes there?") A

name=1nput()

1T name=="David":

| print("Welcome, good sir. You may pass.™)
glcp:

' print("I know you not. Prepare for battle!"™)

STEP 8 What you've created here is a condition, which we
will cover soon. In short, we're using the input from

the user and measuring it against a condition. So, if the user enters
David as their name, the guard will allow them to pass unhindered.
Else, if they enter a name other than David, the guard challenges
them to a fight.

= [ — g 1
usernnput py - /nome/pi/Documents/Python C
fle Edt Shel Debug Options Windows tielp I ple eox Fomat gun options vandows Help

Python 3.4.2 {(default. Oct 10 2014, 13:31:11) there?™)
[GCC 4.9.1] on linux
Type “copyright”. “credits” or “license()” for more information.

3 SIS S EECSEEEEEEEEEE REFI’M_T SZEzEECDECEZCDESZSDoEEZZEmEEDSEZZEsEEHSES=E=
e

Halt! Who goes there?

David

Welcome, good sir. You may pass.

*»37 semeeeeseEEEeEeeeeseeneeeeeesnes RESTAR] zeeeeemeseeesemsm
BED

Halt! who goes there?

Conan

I know you not. Prepare for battle!
s3> |

"‘I print{“Halt! Wwho goes

name=1nput()

. name=="David™;
' print{“Weclcome, good sir. You may pass.”)
I .__-'_':

print{”l know you not. Prepare for battle!™)

Just as you learned previously, any input from a
user is automatically a string, so you need to apply a

TypeCastin order to turn it into something else. This creates some

interesting additions to the input command. For example:

# Code to calculate rate and distance
print(“Input a rate and a distance”)
rate = float(input(“Rate: *))

| *userinput.py - /home/pi/Documents/Python Code/usennput.py (3.4.2)*
| File Edit Format Run Qptions Windows Help

# Code to calculate rate and distance
print(“Input a rate and a distance")
rate = float(input("Rate: "))

STEP 10

Save and execute the code and enter some numbers. Using the
fFloat(input element, we've told Python that anything entered is a
floating point number rather than a string.

To finalise the rate and distance code, we can add:

distance = float(1input(“Distance: *))
print(“Time:”, (distance / rate))

usennput py - /nome/pi/Documents/Python Cocdl
.~ Hle Edr Format Bun QOptions Windows Help

F Code to calculate rate and distance
i print{"Input a rate and 3 4l1sTanCe™)

Python 3.4.2 Shell

fle Edit Shel Debug Qptions Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11) I
[GCC 4.9.1] on linux

Type "copyright™. "credits”™ or "license()"” for more information.
% SEEEEES -

EEsssssssssssssssssssssssssss RESTART sssssssssssssssssss

rate = float({ input{ “Kate: ™))
distance =
printf“Time.",

[ loald inputd "Distance: “))

b5 5.9 (distance / rate))

Halr! wha paa< There?
David

Welcome, good sir. You may pass.
T . -

L

Halt! Who goes there?

Conan

I know you not. Prepare for battle!

i SEEESEEEEEEEEEEEEEEEE A ch]m[ S SS SR EEE RS R e R

P 7 [ ———— -

Input a rate and a distance
Rate: 12

Distance: 24

Timg: 2.0

b e ] I
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Creating Functions

Now that you've mastered the use of variables and user input, the next step is to tackle

functions. You've already used a few functions, such as the print command but Python

enables you to define your own functions.

FUNKY FUNCTIONS

A function is a command that you enter into Python to do something. It's a little piece of self-contained code that takes data,

works on it and then returns the result.

It's not just data that a function works on. They can
do all manner of useful things in Python, such as

STEP 1

sort data, change items from one format to another and check the
length or type of items. Basically, a function is a short word that's
Followed by brackets. For example, len(), list() or type().

*Python 3.4.2 Shell*
File Edit Shell Debug Options Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11) Al

[GCC 4.9.1] on linux
ngl;ﬁayright“. “credits” or "license()" for more information.
STEP 2 A Function takes data, usually a variable, works on
it depending on what the function is programmed
to do and returns the end value. The data being worked on goes
inside the brackets, so if you wanted to know how many letters
are in the word antidisestablishmentarianism, then you'd enter:

len(“antidisestablishmentarianism”) and the number 28
would return.

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help
M Buthen 3 4 3 tdat=1t Ot 106 2014 12-24-44%y  TTTTTTTTTTVVpa
Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type “copyright”, “credits” or “license()” for more information.
>>> len("antidisestablishmentarianism™)

28
>>> |
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STEP 3 You can pass variables through functions in much
the same manner. Let's assume you want the
number of letters in a person’s surname, you could use the following
code (enter the text editor for this example):

name=input (“Enter your surname: )
count=len(name)

print (“Your surname has®“, count, “letters 1in
1t.”)

Press F5 and save the code to execute it.

i
; |
vl d ault. T ¥ 2004, 13:F1:11)
C4.9.1 1imu=
Type “Copyright™. “credits™ or “license( )™ Tor more informati
=xx Jeml antidises Lalyl isdvsnlan Lana h ]
AFF BEEEEREEREEEEEEEEEEFAEEEEEEEEEEREN FEEFEREEEEEEE TEEE
=
Your eiie k-
& FF

STEP 4 Python has tens of functions built into it, far too
many to getinto in the limited space available here.
However, to view the list of built-in functions available to Python 3,
navigate to www.docs.python.org/3/library/functions.html. These
are the predefined functions, but since users have created many
more, they're not the only ones available.

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help
.................................................---------------------------------------------------------------------‘Fqi i
Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type “copyright”, “credits” or “license()” for more information.
»>>> len("antidisestablishmentarianism™)

Enter your surname: Hayward
Your name has 7 letters 1in 1it.
>>> import math

>>>




STEP 5

Additional functions can be added to Python
through modules. Python has a vast range of
modules available that can cover numerous programming duties.
They add functions and can be imported as and when required. For
example, to use advanced Mathematics functions enter:

1mport math

Once entered, you have access to all the Math module functions.

Python 3.4.2 Shell

File Edit Shell Debug Options Windows Help
[ Bl @ & % fdadsals Ot 10 9014 4A%=B4:44% @4 .
Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type "copyright"”, “credits" or "license()" for more information.
»>>> len("antidisestablishmentarianism™)

28

D sesssssssssTsssEEESSeEEEEESEEEE BRESTART ==ssssssssssssssssssssssssssness
>

Enter your surname: Hayward
Your name has 7 letters in it.
>>> import math

>>>

FORGING FUNCTIONS

C Creating Functions

STEP 6 To use a function from a module enter the name of
the module followed by a full stop, then the name
of the function. For instance, using the Math module, since you've
just imported it into Python, you can utilise the square root function.
To do so, enter:

math.sqrt(16)

You can see that the code is presented as module.function(data).

Python 3.4.2 Shell

Eile Edit Shell Debug Options Windows Help
[ Bt 28 % fdad=ale. et 16 048 SR-%4-482 TS
Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[GCC 4.9.1] on linux

Type “"copyright”, “credits” or “"license()" for more information.
>>»> len("antidisestablishmentarianism")

28

A
>2>
Enter your surname: Hayward
Your name has 7 letters 1in 1it.
>>> i1mport math
>>> math.sqrt(16)
4.0
>>> |

There are many different functions you can import created by other Python programmers and you will undoubtedly come
across some excellent examples in the Future; you can also create your own with the def command.

STEP 1

Enter:

def Hello():
print (“Hello

Press F5 to save and run the script. You can see Hello in the Shell,
type in Hello() and it returns the new function.

Choose File > New File to enter the editor, let’s
create a function called Hello, that greets a user.

e Dl =TT IEEEE. SN
letlo py - /nome/pi/Documents/Hello py (3 4
kile Edit Format Hun QOptions Windows Help

det Hello():
print ("Hella™)

Pylthon 3.4.Z Shell

Flle Cdt Shell Debug Options Windows |elp

Python 3.4.2 (defaultr, Oct 19 2014, 13:31:11)

[GCC #:9:1] on ]linux

Type “copyright”. “credits” or "license()" for more information.

T SRS EEAEEE R man HELYTAK] resrssesssssesseseseeneseemeseSESSS

Hellad
FF Y .

Hello
*»»» Hellof)
Helln
I

STEP 2

script to read:

Let’'s now expand the function to accept a
variable, the user’'s name for example. Edit your

def Hello(name):
print ("Hello”,

Hello(*David

name

This will now accept the variable name, otherwise it prints Hello
David. In the Shell, enter: name=("Bob"), then: Hello(name). Your
function can now pass variables through it.

Python 3.4.2 Shedl
File Edt Shell Debug Options Windows Help

|Python 3.4.7 (defaulr, OcT 19 2014, 13:31:211)
[GCC 4.9.1] on linux
Type “copyright”. “credits” or "license()” for more information.

Hello py - /home/pi/Documents/Hello.p
W Eile Edt Fgrmat Run Options Windows Help

V] e Helln(name):
print (“Hello”. name)

relluf"ﬂded"}

-

Helle David

>>> name=({ “Bob™)
| »>> Hello{name)
Hello Bob

33

STEP 3 To modify it further, delete the Hello("David”) line,
the last line in the script and press Ctrl+S to save

the new script. Close the Editor and create a new file (File > New
File). Enter the following:

from Hello import Hello
Hello(*David

Press F5 to save and execute the code.

Python 3.4.2 Shell test.py - /nome/pi/Documents/test

Ele Edt Shell Debug Dptions Windows Help Ele Edit Format Bun Options Windows Healp

Python 3.4.2 (default, Oct 19 2014, 13:31:11) ~ from Helle import Helle
[GCC 4.9.1] on linux

icence( )" for more information, Hellef “David™)

=== RESTART = . =

b B e
Hello David
>33 |

STEP 4 What you've just done is import the Hello function

from the saved Hello.py program and then used it

to say hello to David. This is how modules and functions work: you

import the module then use the function. Try this one, and modify
it For extra credit:

def add(a, b):

result = a + b
return result

S £

Addilion.py - /nome/

N Ele Ede Fgrmat Bun Qptions Windows Help
| def add(a. b):

pi/Documents/Addilion.py (3.4.2)
Ele Edt Shel Debug Options Windows Help
Python 3.4.2 (default. OCt 19 2014, 13:31:11)
[GCC 4.9.1] on linux

Type “copyright™, “credits™ or “license()" for more information. result = a + b
- - EETAHT ------------- - - T, r‘w‘t

33

Hello David

ey namE={ “Bah")
sen Wello{name)
Hella Hab
R

B3

> add{144,.12.2)
156.2

*rr =

== add{213,33.33)
246, 3299999009900 8
WM
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Conditions and Loops

Conditions and loops are what make a program interesting; they can be simple or rather

complex. How you use them depends greatly on what the program is trying to achieve;
they could be the number of lives left in a game or just displaying a countdown.

TRUE CONDITIONS

Keeping conditions simple to begin with makes learning to program a more enjoyable experience. Let’s start then by checking

if something is TRUE, then doing something else if it isn't.

Let's create a new Python program that will ask
the user to input a word, then check it to see ifit's

STEP 1

a four-letter word or not. Start with File > New File, and begin with
the input variable:

word=1nput(“Please enter a four-letter word: )

File Edit Shell Debug Options Windows Help Eila Edit Farmat Bun QOptions Windows Help

Python 2.4_2 (default. Oct 19 2014, 13:31:11) Al
[GCC 4.9.1] on linux

Type “copyright®, “credits” or “license()” for more information,
»2>

word=input("“Please onter 2 four-letter word: *

¥
L E N EE RN N EERERENRERENSSEERRENERESERSSEERERNEERERSESEERSRRERSEESEERERENRRERLSESNSENERDHNHSHNEHN.

Now we can create a new variable, then use the len
Function and pass the word variable through it to

STEP 2

get the total number of letters the user has just entered:

word=1nput(“Please enter a four-letter word: )
word_length=1en(word)

File Edit thrrnat Run Options Windows Help

»

| word=input("Please enter a four-letter word: ")
word_length=len(word)

32 www.pclpublications.com

Now you can use an if statement to check if the
word length variable is equal to four and print a

STEP 3

friendly conformation if it applies to the rule:

word=1input(“Please enter a four-letter word: *)
word_length=1len(word)
1f word_length == 4:

print (word, “is a four-letter word. Well done.”)

The double equal sign (==) means check if something is equal to
something else.

*Untitled*

. File Edit Format Run Options Windows Help
word=input(“Please enter a four-letter word: ")

word_length=len(word)
1T word_length == 4:
print (word, "1is a four-letter word. Well done.™)

STEP 4 The colon at the end of IF tells Python that if this

statement is true do everything after the colon
that's indented. Next, move the cursor back to the beginning of
the Editor:

word=1nput(“Please enter a four-letter word: “)
word_length=1len(word)
1f word_length == 4:

print (word, “is a four-letter word. Well

done.”)
else:

print (word, “is not a four-letter word.”)

i

*Untitled*

File Edit Format Run Options Windows Help
| — . —
word=input("Please enter a four-letter word: ") A
word_length=len(word)
1T word_length == 4:
print (word, "1s a four-letter word. Well done.™)
llelse:
rrint (word, "is not a four-letter word.™)

-




STEP 5

Press F5 and save the code to execute it. Enter

a four-letter word in the Shell to begin with, you
should have the returned message that it's the word is four letters.
Now press F5 again and rerun the program but this time enter a
fFive-letter word. The Shell will display that it's not a four-letter word.

wordgame py - /home/pi/Documents/wordgam
Ele Edt Shell Debug Qptions Windows Heip E‘]:mmrmnmnmmmun{p

pPython 3.4.2 (default. Oct 19 2014. 13:31:11) = ™| word=1nput("Please cnter a four letter word: )
[GCC 4.9.1] on linux word length=len{word)
Type "copyright”. “"credits” or “"license()” for moere information. 1 word_length == 4:
................................... RESTART ssscsssassssssssssssssssssssssss I print (word, “is

a four-letter word. Well dane_.™)

Please enter a four-letter word: wWord |
Word 1€ 2 four-letter word. Well dene.
- - - Egm‘r - e -

print {word, "is not a four-letter word.")

i

| Please enter a Tour-leitter word: Frost
Frost 15 not a four-letter word,

T

LOOPS

<Conditions and Loops

STEP 6 Now expand the code to include another conditions.
Eventually, it could become quite complex. We've

added a condition for three-letter words:

word=1nput(“Please enter a four-letter word: )
word_length=1len(word)
1f word_length == 4:

print (word, “is a four-letter word. Well
done.”)

el word llengthl — 3¢

print (word, “is a three-letter word. Try again.”)
else:

print (word, “is not a four-letter word.”)

worcgame.py - /home/pl/Documents/wordgame.py (34.2) - B X
Ele Ede Shel Debug Dptions Windows |ielp i_l_ﬂ-ﬂrmhmmmuiln |

Python 3.4.3 (defaulr. dct 19 2004, 13:31:01) l [ word=inputd “Plesse enter @ Towr-letber mord; “) &
)

[GCC 4.9.1] on linux | word_lengths len{word
Type “copyright™. “credits” or ~“licensa({)~ for mors informarion
H T EEE e e EE T T

[ 47 word_length == 43
pri s -in

sesssssess RESTAR] ssssssasss - | r L (wo d. r 5 1 l._,-[ | ] :I':l 1
¥ '| Lol word_length == 3:
Please enter a four-letter word: Word print {word, "is a three-letter word. Try again™)
Word 15 a Tour-letter word. Well donme. [ .
i SEesss @ s s s nsEamansEsEeEsE e Eﬂm lllllllllllllllllllllllllllllll -] imrdr f |_ s | }

k]
Please wnler a Tour=leller word: Frost
Frost is net a fowr-letter mord.

sesesseses RECTART @ smmm s s mm mm s s s

*
Pleass snter a four-letrer wmord: Egg
EEE 15 a three-letter ward . Trr again
i 3}

A loop looks quite similar to a condition but they are somewhat different in their operation. A loop will run through the same
block of code a number of times, usually with the support of a condition.

STEP 1 Let’s start with a simple While statement. Like IF,
this will check to see if something is TRUE, then run

the indented code:

hile x < 10:

X = X + 1

=7 T2

*Untitieg*
File Edit Fgrmat Run QOptions Windows Help

Xx=1

while x<10:
print (x)
X=xX+1

STEP 2 The difference between if and while is when while
gets to the end of the indented code, it goes back

and checks the statement is still true. In our example x is less than
10. With each loop it prints the current value of x, then adds one to
that value. When x does eventually equal 10 it stops.

i el T
Python 3 4 2 Shell loop1.py - /nome/pi/D
Elle Edt She|l Debug Options windows Help Ele Edt Format Run Qptions Windows He

Python 3.4.2 (default, Oct 19 2014, 13:31:11) x=1

[6CC 4.9.1] on linux whiile x<10:
Type “"copyright™, “credits"™ or "licensze()" for more information. print (x)
BoY ==oo=== i ==czs=acecc= RESTART === —F s S S S x=x+1

>33

VOO 00 =d LD s U PO =
W

STEP 3 The For loop is another example. For is used to
loop over a range of data, usually a list stored as
variables inside square brackets. For example:

words=| “Cat”, “Dog”, “Unicorn

for word 1n words:
print (word

e e A

loop1.py - /nome/pi/Documents/100L
Fle Edt Fgrmat Bun Qptions Windows Help
mrd;-["[at'; "beg”, "Unicorn 1

Python 3.4.2 Shell

Python 3.4.2 (default, Oct 19 2014, 13:31:11)

[6€C 4.9.1] on Llinwux )
Type “copyright™, “credits™ or “license()~ for more information. for word 1n words:
PSP ——— RESTART print (word)

'-I:‘I‘-Jﬂ-u-h-whl—::
b

W
W
W

3D
Lat
Dog
Unicorn
b ]

STEP 4

for x 1n range (1, 10):

The For loop can also be used in the countdown
example by using the range function:

The x=x+1 part isn't needed here because the range function
creates a list between the first and last numbers used.

e T TR
Python 3.4.2 Shell loop1 py - fnome/pl/Documen
Eile Edt Shell Debug Options windows Help Ele Edt Fgrmat Bun QOptions Windows Help

Python 3.4.2 (default, Oct 19 2014, 13:31:11) for x 1n range (1. 10):
[6CC 4.9.1] on linux print (x)
Type "copyright”, “credits”™ or "license()" for more information. ‘

T
e o
Cat

Dog
linicarn
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Python Modules

Think of modules as an extension that's imported into your Python code to enhance and

extend its capabilities. There are countless modules available, and the Pi has most of
them pre-installed; as do many Linux distros.

MASTERING MODULES

In this instance we're using Windows 10 to demonstrate installing modules, since they're already there in Pi OS. The same
steps apply for those Linux distro that don’t feature any modules, so don’t worry about cross platform compatibility.

STEP 1 Alchough good, the built-in functions within Python STEP 3 The resultis an error in the IDLE Shell, as the
are limited. The use of modules, however, allows us Pygame module isn’t recognised or installed in
to make more sophisticated programs. As you are aware, modules Python. To install a module we can use PIP (Pip Installs Packages).
are Python scripts that are imported, such as import math. Close down the IDLE Shell and drop into a command prompt or
Terminal session. At an elevated admin command prompt, enter:
P (] -
t.i Gt Shell Debug Dptions: Window ek pip install pygame
Python 3.6.2 (v3.6.2:5fd33b5, Jul 8 2017, 04:14:34) [M5C v.1500 32 bit (Intel)]
'I;;ewizzgy:ighc", "credits™ or "license ()" for more information.
| >>> import math

STEP 2 Some modules, especially on the Raspberry Pi, STEP 4 The PIP installation requires an elevated status
are included by default, the Math module being a due it installing components at different locations.
prime example. Sadly, other modules aren’t always available. A good  Windows users can search for CMD via the Start button and right-
example on non-Pi platforms is the Pygame module, which contains  click the result then click Run as Administrator. Linux and Mac users

many functions to help create games. Try: import pygame. can use the Sudo command, with sudo pip install package.
Lgif thon 3.6.2 She = ]
File Edit Shell Debug Options Window Help
Python 3.6.2 (v3.6.2:5fd33b5, Jul & 2017, 04:14:34) [MSC v.1500 32 bit (Intel)]
on Wwin3z
| Type "copyright®™, "credits™ or "license ()™ for more information.
s g S
L Pygame
| Traceback (most recent call last):
File "<pyshell#1l>", line 1, in <module>
import pygame

ModuleNotFoundError: No module named "pvgame'

34 www.pclpublications.com




Close the command prompt or Terminal and
relaunch the IDLE Shell. When you now enter:

STEP 5

1mport pygame, the module will be imported into the code
without any problems. You'll find that most code downloaded or
copied from the Internet will contain a module, mainstream of
unique, these are usually the source of errors in execution due to
them being missing.

(@ Python 3.6.2 Shell = O
File Edit Shell Debug Options

:Pythnn 3.6.2 (v3.6.2:5fd33b5, Jul
on winia

Type "copyright®, "credits"™ or "license()™ for more information.

>>> 1mport pygame

>>>

Window Help
8 2017, 04:14:34) [MSC v.1900 32 bit (Intel)]

STEP 6 The modules contain the extra code needed to
achieve a certain result within your own code, as

we've previously experimented with. For example:

1mport random

Brings in the code from the Random Number Generator module.
You can then use this module to create something like:

for 1 1n range(10):
print(random.randint(1l, 25))

bi"LhtHed“ = []

File Edt Format Run Options Window Help

import random

for 1 in range(l0):
print (random.randint (1, 25))

STEP 7 This code, when saved and executed, will display ten
random numbers from 1 to 25. You can play around
with the code to display more or less, and from a great or lesser
range. For example:

1mport random

for 1 1n range(25):
print(random.randint(1l, 100))

File Edit S5hell Debug Optiont Window Help File Edit Format Run Options Window Melp
: Al import random

s=sssssssss PESTART: Ci/Users/david/Documents/Python/Rod Hunber.p)y Se=ssssssas

14 for 4 in range ({25}

21 print (random.randint (1, 100))

. |

1
o
5
10

13
b

RESTARTY: C:/Users/david/Documents/Python/Rnd Humber.py
=G
11
17
1S
a7

b w8 b o dn B e L £
o 0 s @ =] [

(Python Modules

STEP 8

1mport random
1mport math

Multiple modules can be imported within your code.
To extend our example, use:

for I 1n range(5):
print(random.randint(1, 25))

print(math.p1)

|j§ Rnd Number.py - C:/Users/david/Documents/Python/Rnd Number.py (3.6.2] o 2

File Edit Format Run
import random
import math

Options Window Help

Hh
s |

i in range(s):
print (random.randint(l, 23))

print (math.pi)

STEP 9 The result is a string of random numbers followed
by the value of Pi as pulled from the Math module
using the print(math.pi) function. You can also pull in certain

functions from a module by using the from and import commands,
such as:

from random import randint

for 1 1n range(5):
print(randint(l, 25))

Lﬁk Rnd Number.py - C:/Users/david/Documents/Python/Rnd Number.py (3.6.2) = L]

File Edit Format Run

from random import randint

Options Window Help

for 1 in range({(5):
print (randint (1, 25))

STEP 10 This helps create a more streamlined approach to
programming. You can also use Import module*,
which will import everything defined within the named module.

However, it's often regarded as a waste of resources but it works
nonetheless. Finally, modules can be imported as aliases:

1mport math as m
print(m.p1)
Of course, adding comments helps to tell others what's going on.

| & *Rnd Number.py - C:/Users/david/Documents/Python/Rnd Number.py (3.6.2)* — O] X
File Edit Format Run Options Window Help

import math as m

print (m.pi)
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Debugging

DID YOU KNOW. . that the_ word debuggingin

computing terms comes from
Admiral Grace Hopper, who back in the ‘40s was working on
a monolithic Harvard Mark Il electromechanical computer.
According to legend Hopper found a moth stuck in a relay,
thus stopping the system from working. Removal of the
moth was hence called debugging.
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C++ on Linux

“The most importan
single aspect of sofl
opmentis tot
about what yoU'are

— Bjarne Stroustrup (Developere
creator of G

L8
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C++0n
L INUX

C++ is an excellent, high-level programming language
that's used in a multitude of technologies. Everything
from your favourite mobile app, console and PC game to
entire operating systems are developed with C++ at the
core, together with a collection of software
development kits and custom libraries.

C++ is the driving force behind most of what you use on a
daily basis, which makes it a complex and extraordinarily
powerful language to get to grips with. It's the code
behind Linux itself, as well as most of the behind the
scenes drivers, library Files and control elements of most,
If not all, operating systems.

This section shows you how to start coding in C++ on
Linux using a Raspberry Pi. From there, you can begin to
create great things.

www.pclpublications.com
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Why C++?

C++ is one of the most popular programming languages available today. Originally

called C with Classes, the language was renamed C++ in 1983. It's an extension of the
original C language and is a general purpose object-oriented (OOP) environment.

C EVERYTHING

Due to how complex the language can be, and its power and performance, C++ is often used to develop games, programs,

device drivers and even entire operating systems.

Dating back to 1979, the start of the golden era of home
computing, C++, or rather C with Classes, was the brainchild of
Danish computer scientist Bjarne Stroustrup while working on his
PhD thesis. Stroustrup’s plan was to further the original C language,
which was widely used since the early seventies.

C++ proved to be popular among the developers of the ‘80s,

since it was a much easier environment to get to grips with and
more importantly, it was 99% compatible with the original C
language. This meant that it could be used beyond the mainstream

G C++ code is much Faster than that of Python.

1 ¥include<ioslream>

2 using namespace std;
3
4
3
6
!
3

void main()

computing labs and by reqular people who didn’t have access to the
mainframes and large computing data centres.

C++'s impactin the digital world is immense. Many of the programs,
applications, games and even operating systems are coded using
C++. For example, all of Adobe’s major applications, such as
Photoshop, InDesign and so on, are developed in C++. You will find
that the browser you surf the Internet with is written in C++, as
well as Windows 10, Microsoft Office and the backbone to Google's
search engine. Apple’s macOS is written largely in C++ (with some

] {char ch;
cout<<"IEnler a charalter Lo check 1L 15 vowel or nol"™;
cin>>ch;
switch(ch)
= E
G case':': case'L':
10 cout<<ch<<"™ 15 a Vowel";
11 break;
12 case '=': case'l ':
13 cout<<ch<<" 15 a Vowel";
14 break;
15 case ! case' [ ':
16 cout<<ch<<" 15 a Vowel";
17 break;
18 case '0': case'(0':
15 cout<<ch<<" 15 a Vowel";
20 break:;
21 case 'u': case'lU':
22 cout<<ch<<"™ 15 a Vowel";
23 break:;
3 A Anfnarl + -

40
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Installing - Visual Studic Community 2017 (15.0.26223.1) X
Workloads Individual components Language packs
Windows (3) Sumrﬂar}f
i Universal Wmdmug Platfﬂrm Flevelqpment o .NﬁT de:slitnpi development . . v Desktop development with C...
Bl Create applications for the Universal Windows Platform with C#, Build WPF, Windows Forms and console applications using the
VB, JavaScript, or optionally C++. NET Framework. Included
v Visual C++ core desktop features
Optional
*4 =1 Desktop development with C++
IT Build classic Windows-based applications using the power of the VC++ 2017 v141 toolset (xB6,xb4)
Visual C++ toolset, ATL and optional features like MFC and... C++ profiling tools
Windows 10 SDK (10.0.14393.0)
Visual C++ tools for CMake
= Visual C++ ATL support
Web & Cloud (4) VISU ot AL Spper] |
Windows 8.1 SDK and UCRT SDK
ASP.NET and web development Azure development Windows XP support for C++
Build web applications using ASP.NET, ASP.NET Core, HTML, Azure SDK, tools, and projects for developing cloud apps and MFC and ATL support (x86 and x64)
JavaScrpt, and C5S. creating resources, C++/CLI support
Clang/C2 (experimental)
Standard Library Modules
r_—*.:"“i Node.js development b—~d Data storage and processing NS _
U2 Build scalable network applications using Node,js, an asynchronous &= Connect develop and test data solutions using SQL Server, Azure i E*’ R L O SR R 'D‘Tfe_'?r ‘hif_ )
rent-driven JavaScript runtime Data Lake, Hadoop or Azure ML g il sl i Vo
=veEn - ] ' b - - ' ability to downlioad other software with Visual
Studio. This software is licensed separately, as set

out in the 3rd Party Motices or in its accompanying
icense. By continuing, you also agree to those

Microsoft’s Visual Studio is a great,
free environment to learn C++in.

other languages mixed in depending on the function) and the likes begin with Python and spend some time getting to grips with

of NASA, SpaceX and even CERN use C++ for various applications, programming structure and the many ways and means in which

programs, controls and umpteen other computing tasks. you find a solution to a problem through programming. Once

you can happily power up your computer and whip

out a Python program with one hand tied behind

your back, then move on to C++. Of course,
there’'s nothing stopping you from jumping
straight into C++; if you feel up to the task,
go forit.

C++ is also extremely efficient and performs
well across the board as well as being an
easier addition to the core C language.

This higher level of performance over

other languages, such as Python, BASIC

and such, makes it an ideal development
environment for modern computing,

hence the aforementioned companies

using it so widely.

Getting to use C++ is as easy as Python, all
you need is the right set of tools in which
to communicate with the computerin
C++ and you can start your journey. A C++
IDE is free of charge, even the immensely
powerful Visual Studio from Microsoft

is freely available to download and use.
You can getinto C++ from any operating
system, be it macOS, Linux, Windows or even
mobile platforms.

While Python is a great programming
language to learn, C++ puts the developer
in @ much wider world of coding. By
mastering C++, you can find yourself
developing code for the likes of Microsoft, Apple
and so on. Generally, C++ developers enjoy a higher
salary than programmers of some other languages and

due to its versatility, the C++ programmer can move between Just like Python, to answer the question of Why C++ is the
jobs and companies without the need to relearn anything specific. answer is because it's fast, efficient and developed by most of the
However, Python is an easier language to begin with. If you're applications you regularly use. It's cutting edge and a fantastic
completely new to programming then we would recommend you language to master.

Indeed, the operating system you're
using is written in C++.

Windows 10 ac

debian ubuntu
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Your First C++ Program

The Raspberry Pi makes for a great coding base on which to learn C++. You won’'t need

any complicated, third-party IDEs or to install any extra components. Everything you
need to get started is already built into the Pi.

HELLO, WORLD!

It's traditional in programming for the First code to be entered to output the words ‘Hello, World!' to the screen. Interestingly,
this dates back to 1968 using a language called BCPL.

STEP 1 You can use the included Geany Programmer’s STEP 3 It doesn’t look like much at the moment but you can
Editor to write, compile and execute your C++ code get into what the C++ header commands mean in

on the Raspberry Pi. You can find Geany as the first entry in the due course. Geany uses syntax highlighting, meaning it colour-codes
Programming section from the main Raspberry Pi menu. Click the the code depending on the language. To activate this, save the code
Geany icon to open and start coding. by clicking on File > Save As. Now name the code helloworld.cpp and

click the Save button.

uuuuuuu

li A 4N *
| I < =
5 £ E £ 2 =2
s i - ] - '-'-l
= . ' S R 7

| A
- -"
%

Ly ‘-

i -

] ; 5
4
el

; " £
;9 col 0 - LalnCe

STEP 2 The Geany editor is quite powerful while still being STEP 4 The colour coding helps a lot when your coding.
easy to use. All the code you enter shows in the Now press Enter and start a new command on line
main window and is numbered to help you keep track of your code. 3. Enter the following:
For now, in line 1, enter:

int main()

#1nclude <1ostream
. . Note: there’s no space between the brackets.

lru!e Edt Search View Document Project Build Tools Help
ivBvED 2 X b ¥4 1B I
Symbols | | untitied X | File Edit Search View Document Project Build Tools Help
No symbols found % R SRt = 7|
3 y . - " -Lj_'-_-,-*-
T vavaAg @ X %O +v< B
1 I |
Symbols |2 ‘ helloworld.cpp X
| ~ ||l #include <iostream>
No symbols found 5
|13 int main()
4
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On the next line, below int main(), enter a curly bracket;

1

This can be done by pressing Shift and the key to the right of P on an
English UK keyboard layout.

STEP 5

| *helloworld.cpp - /home/pi,
File Edit Search View Document Project Build Tools Help

Gv8vaid =X
<[ Symbols .‘>rheilnwmrld.cppn‘

% © v < | M

| = ¢ Functions % #include <iostream>
¢ main [3] 3 int main()
4 {
A

"

STEP 6 Notice that Geany has automatically created a slight
indent. This is due to the structure of C++ and it's

where the meat of the code is entered. Now enter:

//My first C4++ program

*helloworld.cpp - /home/pi/Code - (

File Edit Search View Document Project Build Tools Help
B - WA % O v < | M

<‘ Symbols > helloworld.cpp X

#include <i1ostream:>

1Lk

¢§? Functions

¢ main [3) int main()

N bW

{
T //My first C++ program

g1 ==lyA Note again the colour coding change. Press Return
at the end of the previous step's line and then enter:

std: :cout << “Hello, world!\n”;

*helloworld.cpp - /home/pi/(

File Edit Search View Document Project Build Tools Help
T v B8 vag la X e © v 7

<‘ Symbols '> 'heuowmid.cpp x \

#include <iostream>

Hi

,:j? Functions

¢ main [3] int main()

std: :cout << "Hello, world!\n":

bWk

{
T //My first C++ program
|

L

Your First C++ Program

9,

STEP 8

¥

Note that you won't need to backspace to the start of the line,
removing the indent, just by entering the curly bracket Geany auto-
jumps to the correct part of the line, thus ending the code block.

Now you need to close off the code, by inserting the
opposite, closing, curly bracket. On line 7 enter:

File Edit Search View Document Project Build Tools Help

[

| symbols > ‘ helloworld.cpp ‘

#include <iostream>

¢ Functions

& main [3] int main()

std: :cout << "Hello, world!'\n"

X

SO L WM =

{
T //My first C++ program

=

STEP 9 Essentially, these are your first steps into the world
of coding in C++. We will look at the structure of the
code in more detail on the next couple of pages; for now though,
click on the Save button as represented by a filing cabinet with a
green downward pointing arrow.

File Edit Search View Document Project Builld Tools Help
G v 8 v & %O < ME
| Symbols _’}

d} Functions
a? main [3]

Save the current file

1
2
3
4
3
6
7

#include <iostream=
int main()

{
//My first C++ program
gtd: :cout << "Hello, world'!'\n";
X

STEP 10 IF you haven't done so already, it's always advisable
to create a blank folder where you can save all
your code. You can have one each for Python and C++ or simply a
single folder called Code, whichever you prefer. It's not a necessity,
just good housekeeping.

e LT —ErT m " nar "N e

| 2B |88 B =S

“ |__]hin

(a] & 4p | /nome/pi v
v | 43
MagPi Music

—

Videos

F|1

| boot

=]
| \ g
Code Desktop Documents Downloads
r {
+ | ] debootstrap |

v |__|dev oldconffiles

| et -

Pictures Public  python_gam Tempiates

-

Thome

+ [] Code
(@] Desktop

+ 'HL_ Documents
¢ | w] Downloads
3| | MagPi

v | &3] Music

# [ ] oldconffiles
7 (W] Pictures

+ :F:L_" Public

nuthnn _namae
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Structure of a
C++ Program

C++ has a very defined structure and way of doing things. Miss something out, even

as small as a semicolon, and your entire program will fail to be compiled and executed.
Many a professional programmer has fallen Foul of sloppy structure.

#INCLUDE <C++ STRUCTURE>

Learning the basics of programming, you begin to understand the structure of a program. The commands may be different
from one language to the next but you can start to see how the code works.

INT MA|N() int main() initiates the declaration of a
Function, which is a group of code statements

under the name ‘main’. All C++ code begins at the main function,
regardless of where it actually lies within the code.

C++

C++ was invented by Danish
student Bjarne Stroustrup
in 1979, as a part of his

Ph.D. thesis. Initially C++ 1 | . hE’HD‘ﬁ"ﬂ'ﬂfid.ﬁpp vt

was called C with Classes,

which added features 1 Finclude <l1ostream:=
to the already popular C . f -

programming language, A | 3 int main( )

while making it a more " ey |

user-friendly environment 5

through a new structure. & I\ TV / |

Bjarne Stroustrup,
inventor of C++.

#INCLUDE The structure of a C++ program is quite BRACES The open brace (curly brackets) is something that
precise. Every C++ code begins with a directive: you may not have come across before, especially if
#include <>. The directive instructs the pre-processor to include a you're used to Python. The open brace indicates the beginning of the

section of the standard C++ code. For example: #include <iostream> main function and contains all the code that belongs to that function.
includes the iostream header to support input/output operations.

helloworld.cpp X

helloworldcpp X | (| #include <iostream> S—
R #include <iostream> 2 . .
2 3 int main()
4 @1
| B -
| 6 |
7 ¥
g L
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Lines that begin with a double slash are
comments. This means they won't be

COMMENTS

executed in the code and are ignored by the compiler. Comments
are designed to help you, or another programmer looking at your
code, and explain what's going on. There are two types of comment:
/* covers multiple line comments and // a single line.

helloworld.cpp X

| R #include <iostream=
2
3 int main()
4 R{ _
- /My Tirst C++ program
6
7 h
8

While std stands for something quite different, in C++ it
means Standard. It’s part of the Standard Namespace in
C++, which covers a number of different statements and commands.
You can leave the std: : part out of the code but it must be
declared at the start with: using namespace std; not both. For
example:

#1include <iostream>
using namespace std;

helloworld.cpp X
#include <]

ST rean~

int main( )
B
f/My Tirst C++ program
std: :cout << "Hello,

el = ==y W . ' ]
hn"_l _._I_I . i..l ¥

0 = h N & WM

COUT

In this example we're using cout, which is a part of
the Standard Namespace, hence why it's there, as
you're asking C++ to use it from that particular namespace. Cout
means Character OUTput, which displays, or prints, something to
the screen. If you leave std:: out you have to declare it at the start of
the code, as mentioned previously.

| helloworld.cpp X ‘

#include <iostream:
using namespace std;

int main()
=H
//My Tirst C++ program
cout |

O~ n N =

<Structure of a C++ Program

The two chevrons used here are insertion operators.
This means that whatever follows the chevrons is to be

inserted into the std::cout statement. In this case they're the words
‘Hello, world’” which are to be displayed on the screen when you
compile and execute the code.

[ helloworld.cpp X

#include <iostream=
using namespace std;

int main()

{
//My first C++ program
cout << |

W< & Wi

OUTPUTS Leading on, the “Hello, world!” part is what you
want to appear on the screen when the code is

executed. You can enter whatever you like, as long as it's inside the
quotation marks. Sometimes brackets are needed, depending on
the compiler. The \n part indicates a new line is to be inserted.

[ /My first C++ Prﬂgram
cout << "Hello, world!\n"

Finally you can see that lines within a function code
block (except comments) end with a semicolon. This

: AND }

marks the end of the statement; all statements in C++ must have
one at the end or the compiler fails to build the code. The very last
line has the closing brace to indicate the end of the main function.

| helloworld.cpp X |

#include <iost
using namespace std;

=L

int main()
B{
/My first C++ program

cout << "Hello, world!'\n";

W =N &=
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Compile and Execute

You've created your first C++ program and you now understand the basics behind the

structure of one. Let's get things moving and compile and execute, or run if you prefer,

the program and see how it looks.

GREETINGS FROM C++

Compiling and executing code from within Geany is remarkably simple and just a matter of clicking a couple of icons and

seeing the result. Here's how it's done.

Open Geany, if you haven't already, and load up
the previously saved Hello World code you created.

STEP 1

Ensure that there are no visible errors, such as a missing semicolon
at the end of the std::cout line.

_l> 'hellc}worid.cpp X l

#include <iostream=
int main()

B{

//My first C++ program

std: :cout <<

T e e [ e
Hello, worla'\n";

=N N & Wk

IFf your code is ready, look to the menu bar along
the top of the Geany window. Notice that midway

STEP 2

along the line of icons there's a red brick icon. This is Build, which
when clicked runs through the code, checking it against the C++
standards to see if there are any errors that stop it from running.

le Edit Search View Document Project Build Tools Help

LI !;5 ¥ LE? b4 | ﬂﬁi ".LFW' <
Symbols > helloworld.cpp X l m
¢§? Functions | #ginclude <1ostream=
¢® main [3] int main()
=i

//My First C++ program
std: :cout << "Hello, world!\n"j

WO b W
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When you click the Build icon, the pane at the
bottom of the Geany interface displays some

STEP 3

results. IF all is well, you will see a successful compilation, if not then
Geany issues an error along with the line the error was found on.

helloworld.cpp - /home/pi/Documents - Geany

File Edit Search View Document Project Build Tools Help
i —
- E, W éii ‘ v N

I Symbols ‘> | helloworld.cpp ‘

2 X 5 | 110 I

- 1 #1include
¢ Functions 5

¢ main [3] 3 int main()
4 @
5 //My first C++ program
6 std: :cout << "Hell r 1
7
8 |}
g L

e

| g++ -Wall -0 "helloworld" "helloworld.cpp" (in directory: /home/pi/Documents)

‘ Status compilation finished successfully.

With the code successfully built, it's now time to
execute it. Next to the Build icon there’s a paper

STEP 4

aeroplane icon, this is the Runicon. You can’t run code that hasn'’t
been previously built or has an error in place. Click the Run icon.

:nt Project Build Tools Help

X AR Rl

B85 ‘ Run or view the current file
Jjade <1o0stream=

a1n( )

My first C++ program
I:[l: rcout =< Iiil:';l_j_ WO ";;:] '\n" -



STEP 5

When you click Run, the C++ code executes and

a simple Terminal window appears displaying the
results of the code. In the case of this simple code, you can see the
words: Hello, world! in the window; as you've already learned, the
code is cout(ing) (outputting) the contents between the quotesin
the std::cout line.

R P ——— TR A Rpp—_— R— - T

b 2 £ ”
2 X ' © v o M v | (B¢

* | helloworld.cpp X

| zinclude

2

< int main()

4 {

S //My first C++ program

6 std: :cout << "Hello, worl i

; } File Edit Tabs Help

STEP 6

Pressing Return/Enter in the command line box
closes it, returning you to Geany. Let’s alter the code
slightly. Under the #include line, enter:

std;

using namespace

Then, delete the std:: part of the Cout line; like so:

cout << “Hello, world\n”;

el
.

L

b ‘ helloworld.cpp

Zzinclude - =T rean
l]EilJ]E] namespace fit]j

int main()
B{

//My first C++ ptagrﬁm
lcout << "Hello, world!\n";

1
2
3
4
5
6
[
8
9

STEP 7

In order to apply the new changes you need to save
the file, build it and execute it again. Go through the
process as before, you don't need to change the name of the file
unless you want to, of course, followed by clicking the Brick icon,
then the Aeroplane icon.

{
\
|

lloworid.cpp |

-
ch

#include <) ng
using namespace std

int main()

81 :
//My first C++ program
Cout << "Hello |

File Edit Tabs Help

DO~ bLWwh =

L

CCompile and Execute

STEP 8 Just as mentioned previously, you don't need
to have std::cout if you've already declared the
standard namespace at the start of the code. Now, let’s create a
deliberate mistake, to see what happens. Remove the semicolon
From the cout line, so it reads:

cout << “Hello, world!\n”

L= , LIS v o e iii 1iiii? r
} l helloworld.cpp X
1 zinclude - T
2 using namespace std
3
es || B int main()
- 5 31
6 ffM? first C++ p[ggram
7 cout << "Hello. world!\:
B }
0 L

STEP 9 Now try and build the code once more. This time,
notice that the bottom panel is displaying an error,
regarding the missing semicolon. Notice that error reads as being
on line 8, the first character, the closed curly bracket. This is because
there’s an expected semicolon missing before the closed bracket.

ymbols > | helloworid.cpp X

1ctions #lnclude <iostream:>
using namespace std;

main [4]

int main()
=B

‘ern Varnables

std [2] //My first C++ program

cCour << "Hello Wi} ]

]

O~~~ LWk =

STEP 10

Replace the semicolon and under the cout line,
enter a new line to your code:

cout << “And greetings from C++!\n”;

The \n simply adds a new line under the last line of outputted text.

Build and Run the code, to display your handiwork.

Bl i
loworl cpp A
#include
using namespace std;

//My first C++ program File Edit Tabs Help
cout << "H - : - '

cout << '

ant main()

}

" -
DO~ bsEWNE D
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Virus!

that one of the first
programmed computer
viruses that spread outside
of a controlled system, i.e.
into the wild, was called Elk
Cloner and it was coded

in 1982 by Rich Skrenta, a
fFifteen year old student.

Elk Cloner was programmed
to infect the Apple DOS

3.3 operating system, and
attached to a game. When
the game was played Fifty
times the virus would be
activated and instead of
displaying the game the
virus would blank the screen
and display a poem:

Elk Cloner:
The program with a
personality

It will get on all
your disks

It will infiltrate your
chips

Yes, 1t°s Cloner!

It will stick to you
like glue

It will modify RAM too
Send in the Cloner!

www.pclpublications.com
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Using Comments

While comments may seem like a minor element to the many lines of code that

combine to make a game, application or even an entire operating system, in actual fact
they're probably one of the most important factors.

THE IMPORTANCE OF COMMENTING

Comments inside code are basically human readable descriptions
that detail what the code is doing at that particular point. They don’t
sound especially important but code without comments is one of
the many frustrating areas of programming, regardless of whether
you're a professional or just starting out.

In short, all code should be commented in such a manner as to
effectively describe the purpose of a line, section or individual
elements. You should get in to the habit of commenting as much as
possible, by imagining that someone who doesn’t know anything
about programming can pick up your code and understand what it's
going to do simply by reading your comments.

In a professional environment, comments are vital to the success of
the code and ultimately, the company or project. In an organisation,
many programmers work in teams alongside engineers, other
developers, hardware analysts and so on. If you're a part of the team
that's writing a bespoke piece of software for the company, then
your comments help save a lot of time should something go wrong
and another team member has to pick up
and fFollow the trail to pinpoint the issue.

Place yourself in the shoes of
someone who's job it is to find out
what’'s wrong with a program. The
program has in excess of 800,000

lines of code, spread across several
different modules. You can soon
appreciate the need for a little help
from the original programmersin the
form of a good comment.

50
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The best comments are always concise and link the code logically,
detailing what happens when the program hits a line or section. You
don’t need to comment on every line. Something along the lines of:
if x==0 doesn’t require you to comment that if x equals zero then do
something; that's going to be obvious to the reader. However, if x
equalling zero is something that drastically changes the program for
the user, such as, they've run out of lives, then it certainly needs to
be commented on.

Even if the code is your own, you should write comments as if you
were going to share it with others publicly. This way you can return
to that code and always understand what it was you did or where it
was you went wrong, or what worked brilliantly.

Comments are good practise and once you understand how to add a
comment where needed, you soon do it as if it's second nature.
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C++ COMMENTS

(Using Comments j‘

Commenting in C++ involves using a double forward slash ‘//’ or a forward slash and an asterisk ‘/*'. You've already seen some

brief examples but this is how they work.

STEP 1

Using the Hello World code as an example, you can
easily comment on different sections of the code
using the double forward slash:

//My first C4++ program cout << “Hello, world!\n”;

helloworld.cpp X |
1 #include <iostream
2 using namespace std;
3
-1 int main()
5 B{
6 //My first C++ program
7 cout << "Hello, worla'\n’ 3
8 cout << "And greetings from C++!\n";
9 t
10 L

STEP 2

However, you can also add comments to the end of
a line of code, to describe in a better way what's

going on:

cout << “Hello, world!\n”; //This line outputs the
words ‘Hello, world!’. The \n denotes a new line.

Note, you don't have to put a semicolon at the end of a comment.
This is because it's a line in the code that's ignored by the compiler.

helloworid.cpp X |

#include <iostrea
using namespace std;

int main()
B{
//My first C++ program
cout << "Hello, world!'\n"; //This line ouputs the words ‘Hello, world. The \n denotes a new line.
cout << "And greetings fron - T

COD~NOU L WK

}

1

STEP 3

You can comment out several lines by using the
forward slash and asterisk:

/* This comment can
cover several lines
without the need to add more slashes */

Just remember to finish the block comment with the opposite
asterisk and forward slash.

hellowhrid.cpp * ‘

1 #include <iostream=
2 using namespace std;
3
4 int main()
5 B¢
6 //My first C++ program
7 cout << "Hello, world'\n"; //This line ouputs the words 'Hello, world. The °
8
9 B /* This comment can
10 * cover several lines
11 * without the need to add more slashes */
12
13
14 CoOut << AN Qreectings fri
15 }
16 |

Be careful when commenting, especially with block
comments. It's very easy to forget to add the closing

STEP 4

asterisk and forward slash and thus negate any code that falls inside
the comment block.

e —_— —— L= - e =

helloworld.cpp X

#include <io0streams>

using namespace std;

1
2
3
4 ant main()
5 B{
6
7
8
9

//My first C++ program
cout << "Hello, world!'\n"; //This line ouputs the words 'Hello, w
= /* This comment can
10 * cover several lines
11 * without the need to add more slasheg
12
13
14 cout << "And greetings from C++!\n";
15 }
16

Obviously if you try and build and execute the
code it errors out, complaining of a missing curly

STEP 5

bracket }' to finish off the block of code. If you've made the error
a few times, then it can be time consuming to go back and rectify.
Thankfully, the colour coding in Geany helps identify comments

from code.

| Symbols | | helloworld.cpp X ‘
dﬁFUﬂChGHS 1 #lTClUdE <lostresa
2 using namespace std;
<P main [4] 3
| 1[4 int main()
@ BExtern Vanables 5 B
¢ std [2] 6 //My first C++ program
7 cout << . Hello world'\n ..
8
9 g  LJIhAs.comment. san
10 * cover several lines
11 * without the need to add more slashes
12
13
14 cout << "And greetings from C++'\n";
15 }
| ERE. =

STEP 6 With block comments, it's good practise in C++ to
add an asterisk to each new line of the comment
block. This also helps you to remember to close the comment block
off before continuing with the code:

/* This comment can
* cover several lines
* without the need to add more slashes */

Thankfully, Geany does this automatically but be aware of it when
using other IDEs.

i.! J:t] j-Ei ;;!gl!lﬂﬂfglj;n. E;E![]
* cover several lines
* without the need to add more slashes */
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Variables

Variables differ slightly when using C++ as opposed to Python. In Python, you can

simply state that ‘a’ equals 10 and a variable is assigned. However, in C++ a variable has
to be declared with its type before it can be used.

THE DECLARATION OF VARIABLES

You can declare a C++ variable by using statements within the code. There are several distinct types of variable you can

declare. Here's how it works.

Open up a new, blank C++ file and enter the usual
code headers:

STEP 1

#1include <i1ostream>
using namespace std;

int main()

1
¥

‘Variables.cpp X |

#include - >
using namespace std;

I - - =

int main( )
{
I

W=~ & WK =

Start simple by creating two variables, a and b, with
one having a value of 10 and the other 5. You can

STEP 2

use the data type int to declare these variables. Within the curly
brackets enter:

int a;
1Rt b:
a = 10;
=5

Vanables.cpp ¥
| #include <iostream=
using namespace std;

1
2
3
4 int main()
5 B{
6
7
8
-

int a:
ant b
a = 19;
10 h = 5;|
11
12 1
13 -

www.pclpublications.com

STEP 3

You can build and run the code but it won’t do much,
other than store the values 10 and 5 to the integers a
and b. Ignore the warnings about variables set but not used, the code
still works. To output the contents of the variables, add:

cout << a;
cout =< "\n”;
cout << b;

The cout << “\n”; part simply places a new line between the
output of 10 and 5.

Vanables.cpp ¥

1 #include <iostream=
2 using namespace std;
3
4 ant mainmf )
5 B({ rT
6 int a;
7 ant b
8
G a = 10;
10 b = 5;
11
12 cout << a:
13 cout << "\n";
14 cout << b:
15 |
16
| }
|18 L

STEP 4

Naturally you can declare a new variable, call it
result and output some simple arithmetic:

1nt result;

result = a + b;
cout << result;

Insert the above into the code as per the screenshot.

Vanables.cpp X
zinclude < um
using namespace std;

it File Edit Tabs Help
int b;
int result:
10 a = 16;
11 D = 8§
12 result = a + b;
i3
14 cout << a;
15 cout << "\n":
16 cout << b;
17 cout << "\n":
18 cout << result;
19
20
21
22 }
23




STEP 5

You can assign a value to a variable as soon as you
declare it. The code you've typed in could look like

this, instead:
1int a = 10;
int b - 5;

1nt result = a + b;

cout << result;

| | L
Vanables.cpp X

zinclude <iostream
using namespace std;

File Edit Tabs Hel
B{ ' P
ant & = 10:
int b = 5:

VvV d
1
2
3
4 ant main()
5
6
7
a8 int result = a + b;

o

10
11 cout << result:
12
13
14
15 }
16 .

Specific to C++, you can also use the following to
assign values to a variable as soon as you declare them:

STEP 6

int a (10);
int b (5);

Then, from the C++ 2011 standard, using curly brackets:

int result {a+b};

Varables.cpp %

#include ostream
using namespace std;

File Edit Tabs Help

1

2

3

4 int main()

5 B¢ ,

6 int a (10);

7 int b (5);

8 int result {a+b};
9

11 cout << result;

STEP 7

You can create global variables, which are variables
that are declared outside any function and used in
any function within the entire code. What you've used so far are
local variables: variables used inside the function. For example:

#include <iostream>
using namespace std;
1nt StartlLives = 3;

int main ()

1

startlLives = StartlLives - 1;
cout << Startlives;

1 zinclude <iostream=

2 using namespace std;

3 int StartlLives = 3;

4

5 int main( )

6 E{

T StartLives = StartlLives - 1;
a cout << StartlLives;]
L
10 }
11 -

Variables

n

STEP 8 The previous step creates the variable StartLives,
which is a global variable. In a game, for example,
a player’s lives go up or down depending on how well or how bad
they're doing. When the player restarts the game, the StartLives
returns to its default state: 3. Here we've assigned 3 lives, then
subtracted 1, leaving 2 lives left.

|‘a-'rariab'ies_cpp =

1 zinclude -

2 using namespace std;

3 int StartlLives = 3;

4

5 int main()

65 E{

7 StartlLives = StartlLives - 1;
8 cout << StartlLives:
i
10 }
11 -

STEP 9 The modern C++ compileris far more intelligent
than most programmers give it credit. While there
are numerous data types you can declare for variables, you canin
Fact use the auto feature;

#include <iostream>

using namespace std;
auto p1 = 3.141593:

int main()
double area, radius = 1.5;
area = p1 * radius * radius;
cout << area;

Vanables.cpp ¥

#ilnclude <liostream>
using namespace std;
auto p1 = 3.141593;

1

2

3

4

> int main()

6 B

7 double area, radius =
8 area = p1 * radius *
- COUl << area,

10

Y- %
radius;

STEP 10 Although we said to ignore the warnings in Step
3, there's a difference between a warning and
an error. In this case, it's just a simple warning. The new data type,
double, means double-precision floating point value, which makes
the code more accurate. The result should be 7.06858. Essentially,
you can often work with a warning but not an error.

Vanables.cpp X h

Vd

1 zinclude <1 3

2 using namespace std;

3 auto pl1 = 3.141593;

4

5  int main() File Edit Tabs Help
6 G J6B5E
7 double area, radius = 1.5;

8 area = pi * radius * radius;

9 cout << area;
10
11
12 }
13
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Data lypes

Variables, as you've seen, store information that the programmer can then later call up,
and manipulate if required. Variables are simply reserved memory locations that store
the values the programmer assigns, depending on the data type used.

THE VALUE OF DATA

There are many different data types available for the programmer
in C++, such as an integer, floating point, Boolean, character and so
on. It's widely accepted that there are seven basic data types, often
called Primitive Built-in Types; however, you can create your own
data types should the need ever arise within your code.

Type Command

Integer | int
Floating Point | float
Character | char
Boolean | bool
Double Floating Point | double
Wide Character | wchar_t
No Value | void

These basic types can also be extended using the following
modifiers: Long, Short, Signed and Unsigned. Basically this means
the modifiers can expand the minimum and maximum range values
Ffor each data type. For example, the int data type has a default value
range of -2147483648 to 2147483647, a fair value, you would agree.

Now, if you were to use one of the modifiers, the range alters:

Unsigned int = 0 to 4294967295

Signed int =-2147483648 to 2147483647
Short int =-32768 to 32767

Unsigned Short int =0 to 65,535

Signed Short int =-32768 to 32767

Long int =-2147483647 to 2147483647

Signed Long int =-2147483647 to 2147483647
Unsigned Long int =0 to 4294967295

Naturally you can get away with using the basic type without the
modifier, as there's plenty of range provided with each data type.
However, it's considered good C++ programming practise to use the
modifiers when possible.

There are issues when using the modifiers though. Double
represents a double-floating point value, which you can use for
incredibly accurate numbers but those numbers are only accurate
up to the fifteenth decimal place. There's also the problem when
displaying such numbers in C++ using the cout function, in that cout

by default only outputs the first five decimal places. You can combat
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that by adding a cout.precision () function and adding a value inside
the brackets but even then you're still limited by the accuracy of the
double data type. For example, try this code:

#1include <i1ostream>

using namespace std;
double PI = 3.141592653589793238463;

int main()

1

cout << PL;

¥

. =
} ata lypes.cpp #

#zinclude <iostream>
using namespace std;
double PI = 3.141592653589793238463;]

ant main()

T{ cout << PI:
}

OO~ &WwN e L)

Build and run the code and as you can see the output is only
3.14159, representing cout’s limitations in this example.

You can alter the code including the aforementioned cout.precision
Function, for greater accuracy. Take precision all the way up to 22
decimal places, with the following code:

#1include <i1ostream>

using namespace std;
double PI = 3.141592653589793238463;

int main()

1

cout.precision(22);
cout << PIl;

¥




This is mainly due to the conversion from binary in the compiler

cout.precision(22);
cout << PI1;

To be honest, if you're creating code that needs to be accurate to
more than fifteen decimal places, then you wouldn’t be using C++,
you would use some scientific specific language with C++ as the
connective tissue between the two languages.

Z‘lata;‘ypgz_t;p;j R and that the IEEE 754 double precision standard occupies 64-bits
; ;;2;;"3;“@3“5“ of data, of which 52-bits are dedicated to the significant (the
3 double PI = 3.141592653589793238463" significant digits in a floating-point number) and roughly 3.5-bits
. _ . are taken holding the values 0 to 9. If you divide 53 by 3.5, then you
g _ ‘E"t e b arrive at 15.142857 recurring, which is 15-digits of precision.
7
3
9
0

You can create your own data types, using an alias-like system called
typedef. For example:

#include <iostream>
Again, build and run the code; as you can see from the command using namespace std;
line window, the number represented by the variable Plis different ~ typedef 1int metres;
to the number you've told C++ to use in the variable. The output

reads the value of Pl as 3.141592653589793115998, with the int main()

numbers going awry from the fifteenth decimal place. {

metres distance;
distance = 15;
cout << “distance 1n metres 1is:

Calculator — [ ] oy

11

<< distance;

Scientific O

E

ataTypes.cpp X
1 zinclude - -
15.142857142857142857142857142857 2  using namespace std,
4
5 iant main( )
6
7 metres distance;
8 distance = 15:
g cout << "Distance metres 1s: " << distance;
DEG  HYP  F-E Sl |
3200 L
M+ M - MS
x° xY Sin COS tan
10* O Ex Mod _
\J/ d H File Edit Tabs Help
4k CE C —~

This code when executed creates a new int data type called metres.
Then, in the main code block, there’s a new variable called distance,
_|_ which is an integer; so you're telling the compiler that there's
another name forint. We assigned the value 15 to distance and
displayed the output: distance in metres is 15.

-
-
© N U» ™
w O WO K
|

It might sound a little confusing to begin with but the more you use
C++ and create your own code, the easier it becomes.
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SErings

Strings are objects that represent and hold sequences of characters. For example, you

could have a universal greeting in your code ‘Welcome’ and assign that as a string to be

called up wherever you like in the program.

STRING THEORY

There are different ways in which you can create a string of characters, which historically are all carried over from the original

C language and still supported by C++.

STEP 1

#1include <i1ostream>
using namespace std;

To create a string, you use the char function. Open a
new C++ file and begin with the usual header:

int main ()

1
¥

‘ strings.cpp X I

#include <iostream>
using namespace std;

int main()

I

O~ & W=

STEP 2

It's easy to confuse a string with an array. Here's an
array, which can be terminated with a null character:

#include <iostream>
using namespace std;

int main ()

1

char greet[8] = {*"W*, ‘e’, °L°, ‘c’, ‘o’, ‘m’,
ie!, i\@?};

cout << greet << “\n”;

¥

ke
strings.cpp X

#1nclude <lost
using namespace std;

.ream->

int main()
=1
char grestig] ='W, "e°, ‘1", 'c', '0', "W, "9, "W}
cout << greet << "\n"}|

O WM d Wk

-
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STEP 3

Build and run the code and ‘Welcome’ appears

on the screen. While this is perfectly fine, it's

not a string. A string is a class, which defines objects that can be
represented as a stream of characters and doesn’t need to be
terminated like an array. The code can therefore be represented as:

#include <iostream>
using namespace std;

int main ()

1

char greet[] = “Welcome”;
cout << greet << “\n”;

¥

| strings.cpp X |

#include <iostream>
using namespace std;

int main()
81
char greet[] = "Welcome";
cout << greet << "

DO~ &a WhN

}

1

STEP 4

In C++ there’s also a string function, which works in
much the same way. Using the greeting code again,
you can enter:

#include <iostream>
using namespace std;

int main ()

string greet = “Welcome”;
cout << greet << “\n”;
strings.cpp * 1
I = #zinclude <iostream>
2 using namespace std;
3
4 int main()
5 B
6 string greet = "Welcome";
7 cout << greet << "\n";
8
9 |}
19 L




STEP 5 There are also many different operations that you can
apply with the string function. For instance, to get the

length of a string you can use:

#1nclude <i1ostream>
using namespace std;

1nt main (O

1
string greet = “Welcome”;
cout << “The length of the string is: “;
cout << greet.size() << “\n”;

‘ strings.cpp X

1 #include <iostream>

2 using namespace std;

3

4 int main()

5 B{ | |

6 string greet = "Welcome";

7 cout << "The leni B C
8 cout =< greet.size{) L n™:
g9

19 |}

11 =

STEP 6

You can see that we used greet.size() to output the
length, the number of characters there are, of the
contents of the string. Naturally, if you call your string something
other than greet, then you need to change the command to reflect
this. It's always stringname.operation. Build and run the code to see
the results.

STEP 7

#include <iostream>
using namespace std;

You can of course add strings together, or rather
combine them to form longer strings:

int main ()

1
string greetl = “Hello”;
string greet2 = “, world!”;
string greet3 = greetl + greet?Z;
cout << greet3 << “\n”;

h

' strings.cpp * .

1 #include sLrea

2 using namespace std;

3

4 int main( )

5 B |

6 string greetl = Hello ;

7 string greet2 = ", wol :
8 string greet3 = greetl + greet2;
9
10 cout << greet3 << "\n"|
11
12 }
e e

STEP 8 Just as you might expect, you can mix in an integer
and store something to do with the string. In this

example, we created int length, which stores the result of string.
size() and outputs it to the user:

#1nclude <iostream>
using namespace std;

int main ()

i

1int length;

string greetl = “Hello”;

string greet2 = “, world!”;

string greet3 = greetl + greet?;

length = greet3.size();

cout << “The length of the combined strings
is: “ =< length << *\n™
h

STEP 9 Using the available operations that come with the
string function, you can manipulate the contents of a

string. For example, to remove characters from a string you could use:

#include <iostream>
using namespace std;

int main ()

1

string strg (“Here 1s a long sentence 1in a
string.”);
cout << strg << ‘\n’;

strg.erase (10,5);
cout << strg << ‘\n’;

strg.erase (strg.begin()+8);
cout << strg << ‘\n’;

strg.erase (strg.begin()+9, strg.end()-9);
cout << strg << ‘\n’;

¥

It's worth spending some time playing around with
the numbers, which are the character positions

in the string. Occasionally, it can be hit and miss whether you get it
right, so practice makes perfect. Take a look at the screenshot to see
the result of the code.

Fdit Tabs Help
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C++ Maths

Programming is mathematical in nature and as you might expect, there's plenty of
built-in scope for some quite intense maths. C++ has a lot to offer someone who's

implementing mathematical models into their code. It can be extremely complex or

relatively simple.

C++=MC2

The basic mathematical symbols apply in C++ as they do in most other programming languages. However, by using the C++
Math Library, you can also calculate square roots, powers, trig and more.

C++'s mathematical operations follow the same
patterns as those taught in school, in that multiplication

STEP 1

and division take precedence over addition and subtraction. You can alter
that though. For now, create a new file and enter:

#1nclude <i1ostream>
using namespace std;

int main ()

1
float numbers = 100;

numbers = numbers + 10; // This adds 10 to the
initial 100

cout << numbers << “\n”;

numbers = numbers - 10; // This subtracts 10
from the new 110

cout << numbers << “\n”;

¥

‘ maths.cpp X |

1 zinclude OStream

2 using namespace std;

3

4 int main()

5 B4

6 float numbers = 100;

7 numbers = numbers + 10; //This adds 10 to the initial 100
8

9 cout << numbers <<

10

11 numhers = numhers - 18: //This suhtrracrs 10 from rthe new 116

STEP 2 While simple, it does get the old maths muscle
warmed up. Note that we used a float for the
numbers variable. While you can happily use an integer, if you
suddenly started to use decimals, you would need to change to a

Float or a double, depending on the accuracy needed. Run the code
and see the results.
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STEP 3 Multiplication and division can be applied as such:

#1nclude <iostream>
using namespace std;

int main ()

d
100;

numbers = numbers * 10; // This multiplies 100
by 10

cout << numbers << “\n”;

numbers = numbers / 10; // And this divides
1000 by 10

float numbers

cout << numbers << “\n”;

L

[maihs_cp_m e |

1 zinclude <ii m

2 using namespace std;

3

4 int main()

- [=H

6 float numbers = 100;

7 numbers = numbers * 10; //This multiplies 100 by 10
8

9 cout << numbers <<

10

11 numbers = numbers / 16; //And this divides 1000 by 10
12

13 cout << numbers <<

14

15

16 }

17 -

STEP 4 Again, execute the simple code and see the
results. While not particularly interesting, it's an
introduction to C++ maths. We used a float here, so you can play

around with the code and multiply by decimal places, as well as
divide, add and subtract.
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S =209 The interesting maths content comes when you call Sgp==K: 3 Calculating powers of numbers can be done with:
upon the C++ Math Library. Within this header are

dozens of mathematical functions along with further operations. #include <iostream>

Everything from computing cosine to arc tangent with two #include <cmath>

parameters, to the value of PI. You can call the header with: using namespace std;

#1include <iostream> int main ()

#include <cmath> {

using namespace std; float number = 12;

int main () cout << number << “ to the power of 2 1s “ <<
{ pow(number, 2) << “\n”;

) cout << number << “ to the power of 3 1s * <<

pow(number, 3) << “\n”;
cout << number << “ to the power of 0.8 1is

11

| . w | 14 ” .
maths.cpp X << pow(number, 0.8) << “\n”;
1 #include <iostream
2 #include <cmath }
3 using namespace std;
4 _ _ | maths cpp X
5 int main|( ) B i n e lude
6 E[{I 2 #include <
7 3 using namespace std;
4
8 5 int main()
9 5 af
7 float number = 12;
10 } 8
11 L 9 cout << number << " Wer o . << pow(number, 2) <<
10

. ‘ STEP 9 Here we created a float called number with the
STEP 6 SOy gRILing L Square RE A mimoeEr - value of 12 and the pow(variable, power) is where
the calculation happens. Of course, you can calculate powers and

square roots without using variables. For example, pow (12, 2)
outputs the same value as the first cout line in the code.

#1nclude <i1ostream>
#1nclude <cmath>
using namespace std;

int main ()
1

float number = 134;

cout << “The square root of “ << number << “
1s: “ << sgrt(number) << “\n”;

} I R R Y R R R R R N R R Y R N R RN Y PR R R R RN PR RN R R N

STEP 10 The value of Pi is also stored in the cmath header
| library. It can be called up with the M_PI function.

Enter cout << M_Pl: into the code and you get 3.14159; or you can

| maths.cpp X

1 | #include <iostream> ;

2 #include <cmat use it to calculate:

3 using namespace std; _ _

4 | | #1nclude <iostream>
g E?"t i #include <cmath>

7 float number = 134; using namespace std;
3

9 cout << "The square ro - " << number << " '- int main ()

10

11 | |
12 } double area, radius = 1.5;
=

area = M_PI * radius * radius;

STEP 7 Here we created a new float called number and 1
used the sgrt(number) function to display the

square root of 134, the value of the variable, number. Build and run | EthEaon

the code and your answer reads 11.5758.

cout << area << “\n”;

#1include
#include <cmat
using namespace std;

T
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1

2

3

4

S int main()
6

7 double area, radius = 1.5:
a8

9

area = M PI * radius * radius:

11 CoOut << area << N, - - - - - - - - - - - - - ===~ -
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Jser Interaction

There's nothing quite as satisfying as creating a program that responds to you. This

basic user interaction is one of the most taught aspects of any language and with it
you're able to do much more than simply greet the user by name.

HELLO, DAVE

You have already used cout, the standard output stream, throughout our code. Now you're going to be using cin, the standard

input stream, to prompt a user response.

STEP 1 Anything that you want the user to input into the
program needs to be stored somewhere in the
system memory, so it can be retrieved and used. Therefore, any
input must first be declared as a variable, soit's ready to be used by
the user. Start by creating a blank C++ file with headers.

userinteraction.cpp |

1 #include <iostream>
2 using namespace std;
3

a4 int main( )

5 B

5 |

7

8

S |

B L

1

STEP 2

The data type of the variable must also match the
type of input you want from the user. For example,
to ask a user their age, you would use an integer like this:

#1include <i1ostream>
using namespace std;

int main ()

1nt age;

cout << “what 1s your age: “;

cln >> age;

cout <<”\nYou are “ << age << “ years old.\n”;

. : =]
‘ userinteraction.cpp
#1nclude <lostream>
using namespace std;

1

2

=

4 int main()

5 @{

6 int age;

7 cout << "
8 cin >> age;
9

10 cout << "\nYou are " << age << " years olc

www.pclpublications.com

STEP 3

The cin command works in the opposite way from
the cout command. With the first cout line you're
outputting ‘What is your age’ to the screen, as indicated with the
chevrons. Cin uses opposite facing chevrons, indicating an input. The
input is putinto the integer age and called up in the second cout
command. Build and run the code.

R R

File Edit Tabs Help

STEP 4

would use:

IF you're asking a question, you need to store the
input as a string; to ask the user their name, you

#1nclude <iostream>
using namespace std;

int main ()
string name;
cout << “what 1s your name: “;
cln >> name;

11 11

cout << “\nHello, “ << name << “. I hope you’re

well today?\n”;
h

. _ - |
userinteraction.cpp *

zinclude ams:
using namespace std;

1

2

3

4 int main()

° B4

6 string name;

7 cout << "what is your name: "
=) cin >> name;

e

10 cout << "\nHellop ' €< name <<




STEP 5

The principal works the same as the previous code.
The user’s input, their name, is stored in a string,
because it contains multiple characters, and retrieved in the second
cout line. As long as the variable ‘'name’ doesn’t change, then you
can recall it wherever you like in your code.

STEP 6 You can chain input requests to the user but just
make sure you have a valid variable to store the
input to begin with. Let's assume you want the user to enter two
whole numbers:

#1include <iostream>
using namespace std;

int main ()

1

int numl, numZ;

11

cout << “Enter two whole numbers: “;
cin >> numl >> numZ;

111 14

cout << “you entered “ << numl << * and “ <<

numZ << “\n”;

¥

userinteraction.cpp *

#include <iostres
using namespace std;

L

2

3

4 int main( )

SO

& ant numl, num2;
7

g

=

cout << "Ej ol
cin >> numl >> num2;
10
11 cout << " T o<< numl << " | << numZ << "\n";

STEP 7

Likewise, inputted data can be manipulated once
you have it stored in a variable. For instance, ask the
user for two numbers and do some maths on them:

#1nclude <i1ostream>
using namespace std;

int main ()

1

float numl, numZ;

cout << “Enter two numbers: \n”;
cin >> numl >> numZ;

11 11

cout << numl << * +
numl + num2 << “\n”;

6 11

<< numZ << e <<

1 zinclude -
2 using namespace std;
3
=) int main()
T [=E.
5] int numl, num2;
T
8 cout << "Enter two whole numbers: ";
9 cin >> numl >> num2;
10
11 cout << numl << = + << nuUmZg << << numl + numg <<
12

(User Interaction ."

STEP 8 While cin works well for most input tasks, it does
have a limitation. Cin always considers spaces as a
cerminator, so it's designed for just single words not multiple words.
However, getline takes cin as the first argument and the variable as
‘he second:

#1nclude <iostream>
using namespace std;

int main ()

{
string mystr;
cout << “Enter a sentence:
getline(cin, mystr);

” .
NEG

11

cout << “Your sentence 1s: “ << mystr.size() <<

“ characters long.\n”;

1 #1nclude

2 using namespace std;

3

i int main()

5 81 |

6 string mystr;

7 cout << "'E a S
8 getline(cin, mystr);
9

10 cout << "Your " << mystr.size() << "
11

12

STEP 9 Build and execute the code, then enter a sentence
with spaces. When you're done the code reads the
number of characters. If you remove the getline line and replace it
with cin >> mystr and try again, the result displays the number of
characters up to the first space.

STEP 10 Getline is usually a command that new C++
programmers forget to include. The terminating
white space is annoying when you can'’t figure out why your code
isn't working. In short, it's best to use getline(cin, variable) in future:

#1nclude <i1ostream>
using namespace std;

int main ()

1

string name;
cout << “Enter your
getline(cin, name);

full name: \n”;

13

cout << “N\nHello, “ << name << “.\n”;

¥

userinteraction.cpp X

#include
using namespace std;

int main()
B4 |
string name;
cout << "Enter vy Lt ame: \n";
getline(cin, name);

cout << " ' €< name << i

S O DOm0 &WwhN-=

- b
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The Hobblt:

DID YOU KNOW.... released 1in character would be taken along
195z for with 1t. Hl=o, 1in early wersions
warious platforms, Melbourne of the gawme, the non-playing
Hou=se ‘s The Hobbit was a coding characters would often mowve
work of genius. Developed by around the map and capture and
Philip Mitchell and Dr. Veronika kill each other before the player
Megler, The Hobbit was unigquely had even reached that =tage 1in
coded using a parser called the game. There was even a
‘Ingliz=h’ which allowed the player randomiser event in place with
to enter full sentences, such as each =tart of the game, where
"Take =word from Gandali, and kill any character could pick up 3
goblin with 1t.” random object frowm any location,
Thiz meant that, potentially, 1t
Furthermore, each object in the was possible for Thorin to pick
game had a specific size, weight woul up and carry you for the
and =olidity; =o 1f wou =at on entire adventure. Remarkable for
a stool, and someocne picked up a game that took up less than a3EkE
the =tool or threw 1it, then wyour of mMemor:y.

4

YOU are in a narrow pLace waith a dreadrul
drop into a dim wvalley

= e - - - - - - - - - -

Mne L

No time to sit down and start singing
about gold, Thorin.

WO N Y
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<Did You Know...

The Hobbit, a marvel in advanced
coding from 1982.
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Common Coding Mistakes

When you start something new you're inevitably going to make mistakes, this is purely
down to inexperience and those mistakes are great teachers in themselves. However,
even experts make the occasional mishap. Thing is, to learn from them as best you can.

X=MISTAKE, PRINTY

There are many pitfalls for the programmer to be aware of, Far too many to be listed here. Being

able to recognise a mistake and fix it is when you start to move into more advanced territory, and
become a better coder. Everyone makes mistakes, even coders with over thirty years' experience.
Learning from these basic, common mistakes help build a better coding foundation.

EASY VARIABLES

Meaningful naming for variables is a must to eliminate
common coding mistakes. Having letters of the alphabet
is fine but what happens when the code states there’s
a problem with x variable. It's not too difficult to name
variables lives, money, player1 and so on.

SMALL CHUNKS

It would be wonderful to be able to
work like Neo from The Matrix movies.

Simply ask, your operator loads it into
your memory and you instantly know
everything about the subject. Sadly
though, we can't do that. The first

major pitfall is someone trying to learn i V&= painta = LOZ3i
: e 2 var lives = 3;

too much, too quickly. So take coding in .

small pieces and take your time. 4 write("Points: "+points):
5 write("Lives: "+lives);
6 write("Total Time: "+totalTime+" secs");
7 wvwrite('"-—————————m e "V
8 wvar totalScore = 0;
9 write("Your total Score is: "+totalScore);

[/[COMMENTS

Use comments. It's a simple concept but commenting on

your code saves so many problems when you next come to

look over it. Inserting comment lines helps you quickly sift PLAN AH EAD
through the sections of code that are causing problems;

l Ful if t ' l ' f : L : :
also usefulif you need to review an older piece of code While it's great to wake up one morning and decide to code

a classic text adventure, it's not always practical without a
good plan. Small snippets of code can be written without
too much thought and planning but longer and more in-
depth code requires a good working plan to stick to and
help iron out the bugs.

- — e
( START )
. — _—

{ Cipening Cidsosng |
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USER ERROR

User input is often a paralysing mistake in code. For
example, when the user is supposed to enter a number for

Common Coding Mistakes
their age and instead they enter it in letters. Often a user

can enter so much into an input that it overflows some BAC KU PS

internal buffer, thus sending the code crashing. Watch those
user inputs and clearly state what's needed from them.

Always make a backup of your work, with a secondary
ENEAF An i0ESQer HURBAr backup for any changes you've made. Mistakes can be
aswdfdsf rectified if there’'s a good backup in place to revert to for

:"” nAVe enterasd Wrong: Loput ‘hose times when something goes wrong. It's much easier

You have entered wrong input co start where you left DFF, rather than starting From the
LIRS S § 54 T :
: eginning again.
You have entered wrong 1input D€ J49
sdfsdf213213123
You have entered wrong input
123234234234234234
You have entered wrong input
12
the number is: 12

Process returned 0 (0x0) execution time : 21.495 s
Press any key to continue.

RE-INVENTING WHEELS

You can easily spend days trying to fathom out a section

of code to achieve a given result and it's frustrating and

often time-wasting. While it's equally rewarding to solve the IF you're writing code
broblem yourself, often the same code is out there on the to deal with usernames
nternet somewhere. Don’t try and re-invent the wheel, look and passwords, or other
L0 see if some else has done it first. such sensitive data,
then ensure that the
dataisn’tin cleartext.
Learn how to create

a function to encrypt
sensitive data, prior to
Feeding into a routine
that can transmit or
store it where someone
may be able to get to
view L.

Asking for help is something most of us has struggled F your code makes multiple calculations then you need
with in the past. Will the people we're asking laugh at us? t0 ensure that the maths behind it is sound. There are

Am | wasting everyone'’s time? It's a common mistake for ‘housands of instances where programs have offered
someone to sufferin silence. However, as long as you ask incorrect data based on poor Mathematical coding, which
the in the correct manner, obey any forum rules and be can have disastrous effects depending on what the code is
polite, then your question isn't silly. set to do. In short, double check your code equations.

stackoverflow Ques i
o koverflow set terminal x11

Set output

T.",n_'j '}P.‘1 Cluestions |EHEE 'EI 1 5{]{]2
pasbions bigge rmax = 5

nmax = 100

Related Tags complex (x, y) = x = {1, @} + y = {@, 1}
mandel (x, y, z, n) = (abs (z)> rmax || n>= 10@)7 n: mandel (x, vy, z * z + complex (x, y), n + 1)

set xrange [-0.5:0.5]

set yrange [-0.5:0.5]

set logscale z

set samples 200

set isosample 200

set pm3d map

set size square

a= #A#

b= #B#

splot mandel(-a/1@@,-b/100,complex(x,y),®) notitle
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